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Preface 

Welcome 
Congratulations on selecting Time & Chaos as your Personal Information 
Manager! 

When Time & Chaos first appeared as try before you buy software in 1992, it 
struck a chord among harried business professionals. It has been called one of 
the best-kept secrets of the software industry by over a half-million people who 
have purchased it.  From the introduction of this product forward, we have 
continued to update and improve the software to respond to the needs of today's 
users. 

Time & Chaos can be your individual competitive edge because it is built from 
the ground up on accepted standard practices of time management. Real busy 
business professionals designed it for the real world. 

Many of our customers have found that Time & Chaos is much more than a 
software product; rather, it is a process that can potentially take our lives from 
chaos into order. Initially, you may only use the most obvious features of Time 
& Chaos. Over time, as your organizational requirements expand, you will 
discover a wealth of additional features and capabilities that are waiting for you 
when you are ready for them. This manual is a helpful guide to taking full 
advantage of the software you now own. 

After applying Time & Chaos to your own life, you will be more productive, 
less prone to the effects of stress, and you will have a better balance between 
your business and personal life. 

We have managed to keep ahead of our competition only by listening carefully 
to our customers and responding quickly to their needs. Our developers are 
constantly on the lookout for new ideas and improvements for our next update. 
We always welcome your comments, your feedback, and your suggestions! 

Please accept my personal best wishes for making your time usage more 
productive and more rewarding. We appreciate your support and thank you for 
your patronage. 

 
Michael R. Whittingham 
President and CEO 
iSBiSTER International, Inc. 
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Introduction 
Time & Chaos is a type of software program known as a Personal Information 
Manager or PIM. As a time management tool, it can help you maintain a 
phonebook with every phone number or email address you need, can keep a 
schedule of all your appointments and can give you a prioritized to do list where 
things will continue to display day after day until you complete them. 

Time & Chaos is the perfect tool to help you get organized, to manage your time 
and be more successful. It’s easy to get started with, but you’ll find there are 
many powerful features available when you need them.  

What are some of the things that make Time & Chaos unique? 
• A "one screen, do everything" interface so you won't miss an appointment 

because you were on a different screen. 
• All data can be shared in real-time on a network. You can be in your 

calendar at the same time as your assistant! 
• Drag and drop functionality makes it a snap to schedule appointments or 

create to-do items linked to your contacts. 
• Prioritized to do list helps you get everything done, including the items you 

didn't finish yesterday. 
• Provides one-click access for sending email or faxes, visiting web sites, or 

auto-dialing your phone, using other software you already own such as 
Express Plus, Microsoft Outlook Express, Netscape Messenger, Eudora, 
WinFax, and many more. 

• Full support for Microsoft Office for mail merges and reports. 
 

Time & Chaos is a program that stands out as different from other computer 
software. It is packed with power, yet also easy to work with. The rest of this 
user's guide will provide you a wealth of information about the full feature set 
provided in Time & Chaos. With everything it is capable of, Time & Chaos is 
one of the most powerful personal productivity tools you can find. We trust it 
will help you manage your time and organize your chaos! 
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License Agreement 
Prospective customers are encouraged to evaluate an unlicensed version of Time 
& Chaos 5 for up to 21 days for the purpose of deciding whether the program 
suits their needs. At the end of this 21-day evaluation period, a user must either 
cease using Time & Chaos 5 or purchase a license for continued use. Use of an 
unlicensed copy of Time & Chaos 5 for more than 21 days, or use of a licensed 
copy by any person or business other than the licensee, is prohibited and a 
violation of international copyright laws. 

Each licensed user of Time & Chaos 5 is entitled to use Time & Chaos 5 on 
more than one (1) personal computer provided that it is for their use only. 

If Time & Chaos 5 is installed on a computer network, a license is required for 
each Time & Chaos 5 user on that network.  

Licensing brings the legal right to continue using Time & Chaos 5. You will 
receive a Security ID code that will eliminate the "registration reminder" screen 
that begins to appear after an unlicensed copy has been used for more than 21 
days.   

Security ID Codes are non-transferable without express permission of 
iSBiSTER International, Inc. Any attempt to share or transfer Security ID codes 
without consent of iSBiSTER International, Inc. shall be a violation of this 
agreement and will void your license to use Time & Chaos 5. 

Disclaimer of Warranties 
iSBiSTER International, Inc. does not warrant that Time & Chaos 5 software 
will meet your requirements or that the operation of the software will be 
uninterrupted or error free. Nor do we offer any Warranties or Guarantees of any 
kind. You are free to use Time & Chaos 5 in any way you see fit, but AT YOUR 
OWN RISK. 

iSBiSTER International, Inc. is not responsible for any problems or damage 
caused by the software or that may result from using the software, whether 
licensed or not. This includes, but is not limited to, computer hardware, 
computer software, operating systems, and any computer or computing 
accessories. End user agrees to hold iSBiSTER International, Inc. and/or any 
persons associated with the creation of this software harmless for any problems 
arising from the use of the software. 

We regret having to place such a disclaimer in a piece of software. We have 
made every effort to make this software product as efficient and accurate as 
possible; however, in a world full of frivolous and ridiculous lawsuits, we have 
no alternative.
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Obtaining Updates 
From time to time, updates are made available for users of Time & Chaos. If 
you have purchased a copy of Time & Chaos version 5.x, then any updates to 
the 5.x version are available free of charge if you can download them. 

To install an update, you simply run the installation normally and install the 
program in the same location as the previous 5.x version. It should find your 
data and your registration code automatically. 

On the Internet, updates can be found and downloaded from our web site at 
www.isbister.com . 

Contacting Tech Support 
We believe that we offer the best tech support in the industry. Our 
representatives are knowledgeable and are quick to respond to problems.  
Another important advantage is that we offer tech support for FREE, rather than 
charging like some of our competitors. To help us continue to offer the best 
service to you, we ask that you keep the following in mind if you have a 
technical support issue: 
1. Use Online Support first! Almost every question asked of us has 

already been answered in the Support area of our Internet Web Site. You 
can visit us at www.isbister.com/support at any time, day or night and 
search our full online knowledge base to resolve problems promptly. If your 
question is not answered there, you can submit your question and our 
support representatives will reply and post your answer. 

2. Phone Support is available, if needed. If you have a more difficult 
question or wish to have extra priority service, call our Tech Support Center 
at (972) 495-6724. Our offices are open 8:30am to 5:00pm Central Time, 
Monday through Friday. We do our best to keep hold times to a minimum 
and in most cases your phone call is answered right away! 

Contacting Sales 
For Sales Information such as making a purchase or looking up current prices, 
you can visit our web site at www.isbister.com or call us at (972) 495-6724. 

If you have not yet purchased Time & Chaos and would like to, the iSBiSTER 
web site does have a secure online store available 24 hours a day, seven days a 
week. Using our secure store you can get immediate online delivery of your 
software! 

http://www.isbister.com/
http://www.isbister.com/support
http://www.isbister.com/
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Chapter 1: The Telephone Book 

The Telephone Book Window 
The Telephone Book in Time & Chaos is just one of the four areas of the screen, 
but you will find that it will become the central focus or hub of all your 
activities. After all, you are listing the people that you make appointments to 
meet with, that you have things to do for, that you email, fax, call, and write. 
When it comes down to it, learning to use the Telephone Book is the most 
important lesson in using the Time & Chaos program. 

The Telephone Book Window provides an extensive view into your list of 
contacts. The Window is divided into two parts: the Contact Identification area 
and the Communication Access area. 

 

 

The Contact Identification area displays Last Name, First and Company for each 
entry. An indicator for Attached Notes is also provided (the "N" column).  

You can sort your telephone book by Last Name/First Name or by Company. 
You do this by clicking on the appropriate header. Click on the Company 
heading and your Telephone List will sort alphabetically by Company. Click 
Last Name, First and your Telephone List will sort alphabetically by Last Name. 
If you prefer a merged list of names rather than two separate columns, there is 
also a button on the toolbar for Single Column Telephone Book Toggle.  

Once you have the columns sorted the way you wish, you can save your sort 
options as your default view by selecting File, then Save Startup Settings. 
The next time you start Time & Chaos, the column you sorted by will be 
remembered. 

Contact Identification 
Area 
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The Communication Access (or Business Card) area displays name, company, 
title and address of the current selected contact, along with the Telephone 
Numbers and other electronic addresses such as email or web.  

Each contact in your address book can have as many as twenty phone numbers. 
The buttons (or labels) to the left of each access number can automatically dial 
the telephone for a voice call, connect you to an Internet web site, create a fax, 
or send out email. Phone number fields can include fax numbers, email 
addresses, and web sites, in addition to voice numbers. 

 

There are many options and features available in the Telephone Book area (such 
as printing and searching). You can access the important features using the 
toolbars at the top of the Telephone Book window. You can also use your right 
mouse button to bring up a special context-sensitive menu of choices. 

A few of the more important buttons are for Overlay Filter, Search and Report, 
and Categories Filter. The Search and Report button takes you to the Search area 
where you can look for groups of names and create custom reports. You can 
organize your Telephone Book into smaller, more manageable groups with 
Overlays and Categories. There is a thorough explanation of Overlays and 
Categories in the chapter on Special Features in this user's guide. Assuming you 
are using Overlays or Categories, you can click on the appropriate button on the 
Telephone Book toolbar to "filter" your current telephone list to show only the 
contacts in that specific group, rather than your entire telephone book. This is a 
great way to focus on a specific group of people without clutter. 

 

Adding or Editing Records 
Before you can work with your contacts, you must know how to enter them into 
the Telephone Book area. There are a few different ways to bring up a new entry 
screen. The most obvious is to click on the first toolbar button for New in the 
Telephone Book window. If there is a blank row in the Telephone Book area, 
you can double-click on it. If not, you can right-click to bring up the popup 
menu to choose New.  

If you want to edit a record that is already listed, you can simply double-click on 
it or highlight it and click on the Edit button. 

On the Entry/Edit screen, there are a series of section headings listed on the left. 
Over one hundred fields are available for each Telephone Book record, and 
while you are not likely to use all of them, Time & Chaos divides the fields into 
logical groups so that they will all fit on your screen. 

The Main section is where you can enter the First Name, Last Name and 
Company Name. This information is what will end up appearing on the main 
screen.  You can also enter information such as the Prefix (i.e. Mr. or Mr. & 
Mrs.), the Suffix (i.e. Jr. or Sr.), the Title/Position (i.e. President or Chief 
Financial Officer) and Overlay. 

The Overlay field is used to divide your Telephone Book into groups of names, 
such as Personal or Business. The result of using Overlay means that instead of 
viewing the entire Telephone Book, you can choose to "filter" and see just the 
records that are in a specific Overlay. An additional feature is that you can use 
the name of a color in your Overlay field (such as Yellow Pages). When you 

Communication 
Access Area 

Telephone Book 
Toolbar 
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filter on that Overlay, the background of the Telephone Book will change to the 
color in your Overlay name.  

 

If you want to create a new Overlay, simply type something new in the Overlay 
field. Please note that the Overlay field can only contain up to 15 characters, 
including spaces, punctuation, and color names (if any). A more complete 
discussion of Overlays can be found later in this User's Guide in the chapter on 
Special Features. 

The next two sections are Primary Address and Secondary Address. 
These areas are where you enter the mailing addresses you have for this contact. 
The address information you provide can then be used for printing letters, 
envelopes, and mailing labels. Please note the Options button at the top right of 
these screens. This gives you the option to copy or paste whole addresses into 
the correct fields. 

 

The Telephone Numbers section contains two columns with twenty rows, 
allowing you to enter up to twenty points of contact for each record. For each of 
the twenty numbers, you can have a label or “Connection Type” to identify what 
type of information it is. The Connection Type will appear in the left column 
and the actual number or address will appear in the right column. These fields 
can be used to enter email addresses, fax numbers, and web site addresses in 
addition to phone numbers. Just be sure to choose the appropriate label for the 
type of data you’ve entered. 

Once you select the correct labels, you can make these items actually work for 
you rather than just being a simple database. Time & Chaos can be used to dial 
the telephone or launch email, faxes or your web browser to take you to the web 
sites you have entered. 

By the way, if you want to change the default Connection Type labels that come 
up each time you add a new record, you can save your own default labels by 
pressing F7 once you have fixed up one record the way you want the telephone 
labels to be listed. Setting the default labels will NOT affect any telephone 
entries you already have, but instead will impact only new records you add in 
the future. 

Telephone Numbers 
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Special Note to Palm users: The Palm devices have only five telephone number 
fields, instead of the twenty telephone number fields in Time & Chaos. Due to 
this limitation of the Palm device, you should keep any numbers you want to 
have on your Palm in one of the first five telephone number fields of the Time & 
Chaos phonebook. Any other numbers should stay in Time & Chaos, but will 
not be visible on your Palm device. 

 
Connection 
Type 

Purpose 

SMTP: Send Internet email with MAPI message program 
Mailto: Send Internet email with Web Browser email program 

FAX: Send Fax with MAPI message program 

WinFax: Send Fax with WinFax Pro 8.03 or newer 

URL: Store addresses for Internet Web sites 
CompuServe: Send CompuServe mail with MAPI message program 

MSN: Send Microsoft Network mail with MAPI message 
program 

MS: Send Microsoft Mail for networks with MAPI program 

MapQuest: Will launch your web browser to take you to a map for the 
record’s address using the MapQuest web site. Just leave 
the Phone Number field blank. 

MapBlast: Will launch your web browser to take you to a map for the 
record’s address using the MapBlast web site. Just leave 
the Phone Number field blank. 

SkyTel: Will send a pager request through the SkyTel web site. 

 

People use Time & Chaos in many different occupations and fields. Since 
everyone has different needs, uses, and requirements, Time & Chaos provides 
the flexibility to define some of your own fields to track whatever extra data you 
want to keep track of. 

The Custom Fields section contains 12 user-definable fields. These fields 
allow you to personalize Time & Chaos to your specific needs. Perhaps you 
want to track customer numbers or their birthdays or the names of their spouses. 
If so, you can define one of these custom fields to store this type of information. 
If you put your cursor in the label area to the left of the actual custom field, you 
can type a new label for that field. This will set it globally, so any labels on this 
record will also appear on all of your other entries in the Telephone Book. 

 

Category Settings is a place where you can organize your contacts, primarily 
for special report needs or for mail merges. You can click to the left of any box 
and type a label for any of the Category fields you wish to use. Once you have 
labeled your checkboxes, you can check all of the boxes that apply to this 
record. More details about Categories can be found in the Special Features 
section of this guide. 

Although Categories and Overlays are both used to organize your records, 
Categories are different from Overlays. There is a limited number of Categories 
available, but you can make as many Overlays as you want. The trade-off is that 

Connection Type 
Purposes 

Custom Fields 

Phonebook 
Categories 
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you can place an item in more than one Category at a time, but each item can be 
in only one Overlay. 

 

Attached Files allow you to link documents, spreadsheets, pictures, or 
anything else on your PC to a particular Telephone Book record. In the 
Telephone Book record’s entry/edit screen, you can click on Attached Files on 
the left, then look for the options button at the top right of this window or right 
click in this window to attach a new file. Once attached, an icon for it will 
appear. You can also drag a file itself and drop it in this window (if you can see 
both at the same time on your screen).  

Once items are listed here, you can double-click on any file and Time & Chaos 
will launch the necessary program to open the file you attached! The attached 
file list can also be viewed as a page of icons for your documents or as a detailed 
list. 

 

The Attached Notes are a way to enter general information about a contact. 
They are entered in a special Note Editor screen that allows you to use "rich 
text". This includes the use of colors and fonts. There are also options to time-
stamp your notes as you enter them so you can keep a chronological diary of 
entries in the notes. 

 

Keeping a complete history of every meeting and every phone call for one of 
your contacts can be a vital feature of any contact manager program. In a 
Telephone Book record, the Linked Appointments and Linked To Do's 
sections show any of the items that have been linked back to this contact. The 
Appointments and To Do items are listed in chronological order and you can 
double-click on any item you see to go into its details. 

If you right-click with your mouse in this window, you will be given some 
special options if you want to more than just view the list. From this pop-up 
menu, you can add new linked items, you can delete linked items, you can copy 
the information you see to the clipboard, or print it out! 

This list of Linked Appointments and Linked To Do’s will also be available on 
your Contact History printed report if you need a hard copy of this information. 

Each Appointment or To Do item has a field called Linked Name that points 
back to the relevant contact in your Telephone Book. If you don’t find a 
particular Appointment or To Do item that you expected to see, you should go to 
the Appointment or To Do and check the Linked Name field. 

More details on linking Appointments and To Do items to your contacts can be 
found in the chapters on working with the Appointment area or the To Do area. 

 

Working with Multiple Contacts 
There are times when you may want to list more than one person from a 
particular company in your Time & Chaos database. Instead of entering the 
same information each time you add another contact at a company, you can use 
a "cloning" option in Time & Chaos. Create a new Telephone Book record, but 
use the drop-down list in the Company Name field to find the appropriate 
Company Name rather than typing it in again.  When you select it, you will be 

Attached Files 

Contact Notes 

Contact History 
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asked if you want to have the address and telephone information copied into this 
new record. 

If you need to see the contacts that you have at any company, just sort the main 
screen of Time & Chaos by the Company field. (Click on the Company column 
heading.) Now you should see all the contacts at XYZ Corporation listed 
together and then in alphabetical order within that company. 

 

Quick Searches in your Phone Book 
Unlike the Appointments and To Do List (which only show one day of 
information at a time) your Telephone Book can become a large and unwieldy 
list of names that is difficult to find names in. You can always use the Search 
and Report screen to find records, but when you need to find a particular record 
quickly, Time & Chaos offers a few special options right on the main screen. 

If you are looking for a contact and you know their Last Name or their Company 
Name, you can do a “Quick Search” for the person. Start by sorting the 
Telephone Book listings by the field you know and then start typing the person’s 
name. At the top of the Telephone Book list, the column headings will disappear 
and your typed text will show up instead. As you type, the Phone Book list will 
automatically jump to the first match for your search text. 

If you don’t know a Last Name or Company Name, but have other info such as 
their city or their phone number, you can press [Control-F] on your keyboard 
to bring up a Find screen. Type your search text and click Find First to look for 
the first person that has this text anywhere in the record, including Notes! If 
there is more than one match, the Find window will show you how many total 
matches there were and will let you Find Next to jump to the next record. 

 

 

Dialing the Phone 
A very useful feature of an information manager program like Time & Chaos is 
the ability to auto-dial your telephone using the numbers you have typed in for 
each person. This ability removes dialing errors and is able to speed dial the 
number for you.  

You might not realize that your computer already has a dialer program built-in, 
installed by Microsoft as part of Windows. This dialer program is named Phone 
Dialer, and while it is very basic, it does the job and works well with Time & 
Chaos. 

Phone Dialer should start automatically whenever you attempt to autodial a 
telephone number, but if you want to start it on your own to check its 
configuration, you should find it by going to your Windows Start button, then to 
Programs, then to Accessories. Inside Phone Dialer, the Tools menu has all the 
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configuration options you will need to teach it your local area codes and dialing 
rules. 

In Time & Chaos, you should include the area code with each telephone number 
you store, even the numbers in your local area code for which you 
normally do not dial the area code. Microsoft’s Phone Dialer will look at each 
number to see if it is in your area code or not and will dial it appropriately. You 
also do not need to enter a "1" for long distance numbers, as Microsoft's Phone 
Dialer will add it automatically if required. 

The suggested format for telephone numbers is to place the area code in 
parentheses, then type a space, then type the actual phone number. If the number 
is for a country other than your own, you can also enter the country code at the 
beginning. An example, including country code would be +44 (171) 123-1234. 

Microsoft's Phone Dialer is a good program for the basics of placing a telephone 
call. If you wish to upgrade your dialing software, though, be certain that your 
new dialer is TAPI-compliant and that it will install in Windows as the new 
default dialer. Time & Chaos is a TAPI-compliant program and will 
automatically begin to work with whatever TAPI-compliant dialing software 
you are using whenever voice calls need to be placed. 

 

Sending Email 
Time & Chaos can provide one-click access to sending messages to your 
contacts. While Time & Chaos is not an email program itself, we do have an 
email client available separately named Express Plus. Express Plus offers 
advanced features just for Time & Chaos users to allow you to send out 
personalized emails to groups, to share mailboxes on a network or simply see 
which incoming emails are from people in your address book. You can find 
details and a trial version of Express Plus on our web site at 
http://www.isbister.com/ . 

For basic outgoing email, Time & Chaos can also work with whatever email 
program is your default one in Windows, including Microsoft's Outlook 
Express, Netscape Messenger, Eudora Pro and other standard email programs 
for Windows.  These email clients work in conjunction with your web browser 
in Windows to take outgoing message requests from programs like ours. 

To add an email address for a contact, you can enter a new "telephone number" 
with a Connection Type of mailto: with the complete email address in the actual 
telephone number field. An example of a complete address would be 
mickey@disney.com .  

When you are on the main screen, you can click on the mailto: button, and Time 
& Chaos will use your default email program in Windows to open a new 
message with your contact's email address already filled in. You can then write 
and send your message as normal in your email program. 

 

Sometimes, instead of using your browser's email program for Internet email, 
you may want to use another type of mail program that is MAPI compliant 
rather than browser-dependent. An example of this would be Microsoft Outlook, 
Microsoft Exchange or Windows Messaging. While not as easy to use (or as 
light on resources required), MAPI mail programs offer you extra functionality, 
including the ability to send faxes as well as email. Time & Chaos is fully MAPI 
compliant, so it can be used as a launching pad -- a place to start email or faxes 
to people in your phone book. 

Using MAPI for email 

http://www.isbister.com/
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Assuming that you already have a MAPI mail program set up on your PC, 
sending an email is as simple as clicking a button. Find the person in the phone 
book with whom you wish to communicate. When you click on their name, the 
right side of the phone book window will display their contact points: telephone 
numbers, email addresses and fax numbers.  

The first thing to notice is that the buttons for some of these items have a colon 
":" after the text. This colon is what you use to let Time & Chaos know that this 
is not a normal telephone number, but is a MAPI Address instead. A button of 
FAX: would launch a fax and the SMTP: button is for Internet Mail. Any other 
MAPI mail type can also be supported such as CompuServe Mail or Microsoft 
Mail.  

Once you click on a button such as SMTP:, you will receive a message to 
confirm that the address is correct before clicking on OK. At this point, Time & 
Chaos will now ask Windows to open a MAPI message. Windows will look for 
your MAPI program and will open a new message pre-addressed for you. To 
finish the message, you will use your email editor to type in the subject and 
create the message. When you are done, click on send, and your MAPI mail 
program will take care of the rest. 

 

Launching to Web Sites 
The Time & Chaos Telephone Book can be used to store Internet web site 
addresses in addition to standard voice telephone numbers for your contacts. 
Web sites will be viewed with your default web browser, be that Microsoft’s 
Internet Explorer or Netscape Navigator. There is nothing you need to setup in 
Time & Chaos to make this happen. You just need to have a web browser and 
Internet connectivity already configured in Windows. 

To enter web addresses, just enter a new "telephone number" with a Connection 
Type of URL: with the complete address in the actual telephone number field. A 
complete address would be www.isbister.com , for example. When you are on 
the main screen of Time & Chaos, you can then click on a URL: button to open 
that web site. If your web browser is not running, this process should start it 
automatically for you. 

Besides using the Time & Chaos to store web site addresses, Time & Chaos also 
supports MapQuest and MapBlast, two sites on the Internet that will produce 
maps for you when you supply an address. MapQuest can be found at 
www.mapquest.com and MapBlast is located at www.mapblast.com . To use 
either map site in Time & Chaos, just change one of the telephone labels on a 
record to "MapQuest:" or "MapBlast:". When you click on this button on the 
main screen, Time & Chaos will send this person's address to the map web site. 
The result is that your web browser will be launched to display a map to this 
person's location. 

 

Using Fax software 
Time & Chaos is capable of working with a fax program to help you deliver 
faxed messages to people in your telephone book. There are two types of fax 
programs Time & Chaos can support: the first is WinFax and the second is a 
MAPI-based fax program, such as Microsoft Fax. 

Configuring Time & Chaos to use one fax program or the other is quite simple. 
You need only to use the appropriate phone label for the right type of fax 

http://www.mapquest.com/
http://www.mapblast.com/


 

Time and Chaos User's Guide Chapter 1: The Telephone Book  ••••   13 

software. For WinFax users, the phone label for the fax number should be 
WinFax:. For users of other programs, the phone label should be simply FAX:. 

Once you have the appropriate label, you can use Time & Chaos as a “launching 
pad” to start the fax process. 

Note: Microsoft Fax is distributed with Microsoft Office and Microsoft Outlook.  
To have it work correctly, you must have fax software installed and configured 
as a service with Microsoft Outlook so that it knows what to use when a fax 
needs to be delivered. It is also very particular about the format used for the fax 
number. You should enter all your fax numbers in this format to ensure proper 
delivery: +1 (972) 530-6566. 

 

Printing in the Phone Book 
Time & Chaos can print out Telephone Books, Address Books, Contact Profiles, 
and Envelopes, and Mailing Labels based on the contacts listed in your 
Telephone Book. These printouts can be used with your paper based Day-Timer 
or just to throw in your briefcase. Time & Chaos can even print on specially 
formatted Day-Timer paper that is already hole-punched and perforated for easy 
separation and use.  

The Telephone Book printout will contain the names in your database, along 
with all of their telephone numbers. The Address Book will print the same 
information, with the addition of the primary and secondary address 
information. 

A Contact Profile is a way to get all the information about a particular record 
in your Telephone Book. 

Envelopes can be printed for any record or group of records in your Telephone 
Book. You can include a return address, a postal barcode, and choose to mail to 
their primary or secondary address.  

Support for Mailing Labels is also built into Time & Chaos. Supported are the 
most popular Avery © Label sizes for standard printers. When you select the 
Mailing Labels option, labels for each of the contacts in your current telephone 
book will automatically be generated.  

If you own a Dymo/CoStar LabelWriter Printer, Time & Chaos provides an 
additional print option for Dymo/CoStar Label(s), which will send the 
contact you have selected on the main screen to the CoStar printer to produce a 
label for you. 

Once you select the report you wish to print, you will be taken to the Print 
Preview screen where you can adapt the layout and report options to your needs. 
Please see the chapter on Printing for details on this area if you need more 
information. 

In addition to these standard print jobs, remember that you can always use the 
Search and Report screen to generate your own custom Telephone Book report 
or use the mail merge capabilities to generate your own special mailing labels or 
envelopes in your word processor. With the added capabilities of these other 
options, you can print out just about anything you wish, the way you want to. 
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Creating Web-ready Telephone 
Books 
If you have a company or personal web site, you may wish to make the 
information you have entered into Time & Chaos available to others through the 
Internet. You may also want to attach a telephone or address book to an email to 
a person who does not have Time & Chaos loaded on their machine. Time & 
Chaos can help you accomplish this through some special output options.  

To generate a Web-ready Telephone or Address Book, follow the normal 
printing instructions for these items. However, instead of printing from the Print 
Preview screen, click on the File menu at the top left and select the option to 
Save as HTML Page. You will be given the opportunity to indicate a name 
and location for the file so you can find it later. 

 

Custom Copy 
Custom Copy allows you to create your own special block of text, including 
the fields you wish, that could be easily Copied to the Windows Clipboard to be 
placed in another document or application using the Paste command. 

To access Custom Copy, you need to right-click on a name in your Telephone 
Book and then select Copy Address. There you will find the option to copy 
their Primary Address, Secondary Address or to Custom Copy. You will also 
have an option to Set Custom Copy to control what Custom Copy will do. 

Selecting Set Custom Copy will bring up a new window for Custom 
Clipboard. On the left is a list of the Time & Chaos Field Names. On the right is 
your current Clipboard Format.  On the Clipboard Format side of this window, 
you can type your own text as well as insert a field from Time & Chaos by 
double-clicking the field name from the provided list. 

Once you have the format the way you want it, click on the Save button to lock 
this in for the future.  
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Chapter 2: Appointments 

The Appointment Window 
The Appointments Window provides a place to schedule the events and 
meetings you have each day. As you move from day to day, your current 
schedule is always visible for you. You can also track important days such as 
Birthdays, Holidays, and Anniversaries. 

The Appointment Window provides an extensive view into your collection of 
time commitments. It displays all commitments scheduled for the selected day, 
including the times and descriptions. Indicators for Alarm Sound (A), Linked 
Name (L) and Attached Notes (N) conditions are also shown.  

You can access all of the options available in the appointment area by using the 
toolbar at the top of this window. You can also use your right mouse button to 
right-click in the appointment area to bring up a popup menu of context-
sensitive options. 

 

You can organize your Appointments into smaller, more manageable groups 
with Overlays. Overlays allow you to separate your personal items from your 
work items. Just click on the Overlay button on the toolbar and then choose the 
Overlay you wish to "filter" on and you can focus on those particular items. You 
can also use the Category Settings feature to accomplish a similar task. There is 
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a thorough explanation of Overlays and Categories in the chapter on Special 
Features of this user's guide. 

If you wish to concentrate on the Appointment area and ignore (temporarily) the 
other areas of Time & Chaos, you can select a special screen layout from the 
View menu called Appointments Only. This will provide an alternate layout 
for the entire Time & Chaos screen to display a focused view of your 
Appointment data. It will continue to display a calendar for you, but below the 
calendar, it will display a mini-TimeBar to graphically display your schedule. 
When you are ready to return to normal, you can go back to the View menu and 
choose another Screen Layout, including the normal default layout. 

 

 

Adding or Editing Records 
There are a few different ways to bring up a new entry screen in the 
Appointment area. If you are scheduling a meeting with someone in your 
Telephone Book, the easiest way to add an item is to find the correct name in the 
Telephone Book and drag and drop it down to the Appointment window. When 
you drop it, an entry screen will popup for you and you can finish filling in the 
blanks. 

If you are entering an appointment that does not need to be linked to a 
Telephone Book record, you can just click the Add button on the Appointment 
window toolbar. 

If you want to edit an existing Appointment item, you can simply find it and 
double-click on it to open the same screen. 

In the Main section are the fields for Appointment Date, Start Time, End Time, 
Description, Item Color, Overlay, Linked Name and Alarm options. There is 
also a button to access the Attached Notes. 

Appointment Date is a specific day on which the Appointment is scheduled. 
By default, the date is the same as the one selected on the main screen. If you 
want to change to another date, you can click on the drop down arrow at the end 
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of this field to select a date using a calendar, or you can type it in yourself with a 
standard date format. 

 

The Start Time and End Time fields allow you to specify the specific 
duration of your Appointment. You may wish to enter (any standard time 
specification) the desired time just by typing or, if you prefer you may use the 
drop down lists to select a time. Using these fields will allow this time to be 
"blocked off" your schedule. Both of these fields are optional if you do not have 
or want to list this information. 

The Description is used to define the purpose of the Appointment. If the 
description has an @ followed by a telephone number, you could also dial from 
this appointment, if the need arose. 

Item Color allows you to pick a color to make the appointment stand out from 
the others in your Appointment Window on the main screen. 

You can organize your Appointments by using Overlay. You can define 
Overlay values and use them to classify specific Appointments. Examples of 
Appointment Overlay values could be "Vacations", "Personal" or "Business". 
Time & Chaos maintains a reusable list of Overlay values that you have used. 
You may select from these by clicking on the "down arrow" at the end of this 
data field. 

If you wish to place an Appointment in a specific Overlay, select it from your 
current list of Appointment Overlays. Click on the "down arrow" at the right end 
of the Overlay data field and make your selection. If you wish to place an 
Appointment in a new Overlay, enter the description of the new Overlay into the 
Overlay data field. New Overlay values entered are added to your current list of 
Overlays. (Overlays are discussed in more detail in the chapter on Special 
Features.) 

Overlays can also be very useful in printing, because Overlays allow you to 
filter out other data from your calendars and reports. For example, you can make 
an Overlay for employee vacations or your son's Little League schedule. If you 
choose to view just the Overlay you want instead of All on the Main screen, then 
choose to Print, you can produce a calendar with just the information you want: 
a vacation schedule to post on the bulletin board at work or your son's schedule 
to put on your refrigerator at home. 
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Appointment records may be directly associated with individual entries in your 
Telephone Book using the Linked Name field. By using this field to connect 
your Appointment to a Telephone Book record, you can build and maintain a 
complete Contact History for each person.  

If you drag a name from your Telephone Book and drop it into the Appointment 
Window, Time & Chaos will create a new Appointment and will automatically 
link it to the contact. If you entered the Appointment on your own or imported it 
from another program, you can link the Appointment manually by using the 
drop-down list in the Linked Name field to find the appropriate person or 
company. (The drop-down list will be sorted the same way the Telephone Book 
is sorted upon startup.) 

Once an Appointment is linked to a contact, Time & Chaos will display a  + in 
the "L" (for Linked) column. You will also be able to click on the Appointment 
to highlight it and have the Telephone Book jump to the appropriate contact for 
you. 

 

Time & Chaos has the ability to notify you in advance of an Appointment. By 
setting up the information in the Alarm related fields, you can control how and 
when you will be notified about an upcoming appointment. 

Checking the Sound Alarm checkbox will allow Time & Chaos to sound an 
alarm prior to its scheduled start time. 

The Alarm Lead Time is where you specify the length of time prior to an 
Appointment's scheduled start time at which Time & Chaos should sound the 
alarm. You can choose from three available time measurements (i.e., minutes, 
hours or days) and you can specify your desired time as a whole number. 

When Time & Chaos determines that an Appointment alarm needs to be 
sounded, the .WAV File of your choice will be used to issue the audible alarm. 
To the right of the Sound Alarm checkbox is a button that looks like a file 
cabinet. You can click on this icon and browse for the .WAV file of your choice 
to be played anytime an alarm occurs. 

By default, Time & Chaos has alarms enabled. You can use the Time & Chaos 
Preferences, however, to change the defaults for these fields. On the main 
screen, use the File menu to open your Preferences. In General Options, there is 
a field you can use to define your Default Alarm .WAV File. You can also use 
the Appointment Options n Preferences to control other preferences, including 
the Default Alarm Lead Time and the Alarm mode. 

 

Attached Notes are a way to enter general information about an Appointment. 
They are entered in a special Note Editor screen that allows you to use "rich 
text". This includes the use of colors and fonts. There are also options to time-
stamp your notes as you enter them so you can keep a chronological diary of 
entries in the notes. 

 

Category Settings is where you can organize your Appointments, primarily 
for special report needs or for filtering the main screen’s Appointment list. You 
can click to the left of any box and type a label for any of the Category fields 
you wish to use. Once you have labeled your checkboxes, you can check all of 
the boxes that apply to this record.  

Linked Name 

Alarm Notifications 

Appointment Notes 

Appointment 
Categories 
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Later, you can either use the Search and Report engine to find Appointments in 
particular Categories or you can use the Category Filter button on the 
Appointment toolbar to show only certain items on your schedule.  

One example of how to use the Appointment Categories might be to list 
different people in your company or family that each Appointment might apply 
to. As you enter Appointments, you can use your Category Settings to indicate 
all the people who need this Appointment. In the future, you can use the 
Category Filter button on the Appointment toolbar to find the Appointments for 
a particular person and then make a printout to give to them with just their 
schedule shown. 

More details about using Categories can be found in the Special Features section 
of this guide. 

 

Often, you may have appointments that need to be repeated at a definable time 
interval. For example, you may have a staff meeting on the first Monday of each 
month, you may have a social event every Tuesday or you may have a project 
review each month on the 15th. 

Time & Chaos allows the user to select a repeat period (days, weeks, months, 
years) and specify a frequency at which this period is to be repeated. The 
Appointment is then automatically repeated by Time & Chaos according to your 
specifications so that you do not have to enter each item individually. 

 

Let's look at one typical situation. You have a staff meeting on the first Monday 
of each month that is scheduled to start at 10:00 am and end at 11:00 am. You 
wish to have Time & Chaos store this repeating Appointment for the next six 
months. Using the calendar area of the main screen, you would position yourself 
on the first Monday of the current month and create a new Appointment.  

As you setup the details of the Appointment, select Repeat Options on the left 
side of the entry screen, choose a repeat period of "month(s)" and a frequency of 
"1". You would also specify a value for the Until the following date field 
such that the Appointment would be repeated for the next six months. Time & 
Chaos notes that you are repeating monthly and will allow you to check a box 
that specifies "The first Monday of each month" so that your Appointment will 
be repeated properly. If you did not check this box, the Appointment would be 
repeated monthly on that specific date. 

Repeat Options 
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Time & Chaos will remember that this appointment is part of a repeating series. 
This means that if you need to edit the times on the appointment, you can edit 
just the current one. When you save the newly edited record, you will be asked 
if you want the same change to be made to all the future instances of that 
appointment as well. Similarly, when you delete an item that has been repeated, 
you will be asked if you want to remove the future instances of that appointment 
as well. 

 

Attached Files allow you to link documents, spreadsheets, pictures, or 
anything else on your PC to a particular Appointment item. In the Appointment 
item’s entry/edit screen, you can click on Attached Files on the left side of the 
entry/edit screen, then right click in this window to attach a new file. Once 
attached, an icon for it will appear. You can also drag a file itself and drop it in 
this window (if you can see both at the same time on your screen).  

Once items are listed here, you can double-click on any file and Time & Chaos 
will launch the necessary program to open the file you attached! The attached 
file list can also be viewed as a page of icons for your documents or as a detailed 
list. 

 

Rescheduling Appointments 
As situations develop, it is likely that you will need to reschedule Appointments 
to a more appropriate date in order to meet your schedule demands. If so, there 
are a few easy ways to move items from one day to another. 

If you drag an Appointment from the Appointment area and drop it on another 
day in the Calendar area, you will be provided a choice to move or copy the 
Appointment to the new date. 

If you want to move the item to another month, you can always double-click on 
the specific Appointment you wish to reschedule and simply edit the Date field 
to your new date. 

Time & Chaos also offers a special Screen Layout called the 12 Month 
Planner. You can select this by going to the View menu at the top of the 
screen, then to Screen Layouts, then to 12 Month Planner. This layout will 
provide a new window called YearView that will display the current and next 11 
months. Once the month is displayed that you want to move items to, you can 
drag and drop the Appointment you want to reschedule to the new date. 

 

Special Occasions 
Special occasions such as a Holidays or Birthdays can be entered easily. Create 
a new Appointment, but leave the start time and end time fields blank. Go 
directly to the Description field and enter the purpose of the item, then save it. It 
will appear at the top of your Appointment list, above all the other items you 
have scheduled, to act as a sort of Day Title. 

You can also use the repeat option feature when you enter Birthdays or 
Anniversaries so that you do not have to enter this item each year. 

On the iSBiSTER Web site, there are "Transportable Records" with the holidays 
for many different countries available. Visit www.isbister.com and visit the 

Attached Files 

http://www.isbister.com/
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Download area to find the Transportable Records we have created. This will 
save you the effort of entering holidays on your own. 

 

Printing with Appointments 
To print out calendars with your Appointments for your current Overlay, use the 
Print button on the Appointment toolbar or right click in the Appointment 
window and select Print on the popup menu.  

When printing from the Appointment Area, you will be given the option to print 
out Monthly Calendars, Weekly Calendars, Daily Calendars, Yearly 
Calendars, and Day Plans. The Day Plan is a combination of your To Do list 
and Appointment Schedule for the given date. Once you select the report you 
wish to print, you will be taken to the Print Preview screen where you can adapt 
the layout and report options to your needs. Please see the chapter on Printing 
for details on this area if you need more information. 

In addition to these standard print jobs, remember that you can always use the 
Search and Report screen to generate your own custom Appointment report. 
You can choose the fields you wish to include and choose a range of dates you 
wish to report on. Full details can be found in the chapter on using the Search 
and Report screen. 

 

Creating Web-ready Calendars 
If you have a company or personal web site, you may wish to make the 
information you have entered into Time & Chaos available to others through the 
Internet. You may also want to attach a calendar to an email to a person who 
does not have Time & Chaos loaded on their machine. Time & Chaos can help 
you accomplish this through some special output options.  

To generate a Web-ready calendar, follow the normal printing instructions for a 
Monthly, Weekly, or Daily calendar. However, instead of printing from the Print 
Preview screen, click on the File menu at the top left and select the option to 
Save as HTML Page. You will be given the opportunity to indicate a name 
and location for the file so you can find it later. 
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Chapter 3: The To Do List 

The To Do Window 
The To Do area provides a way for you to list the tasks that must be completed, 
to prioritize them, and then mark them as Done when you have completed them. 
Most users list their telephone calls in the To Do area as well. 

A special feature of Time & Chaos is that if you do not finish a task today, it 
will automatically display tomorrow as well. In fact, it will continue to display 
until you either complete it or delete it! Even if you shouldn't put off until 
tomorrow what you can do today, Time & Chaos will still help to remind you of 
all your To Do items. 

The To Do Window provides an extensive view into your collection of planned 
activities. This window displays all open activities as of the currently selected 
date. The Priority Level (P) and Description are displayed for each current entry. 
Indicators for Attached Notes (N) and Linked Name (L) are also provided. 

 

You can access all of the options available in the to do area by using the toolbar 
at the top of this window. You can also use your right mouse button to right-
click in the to do area to bring up a menu of context-sensitive options. 

If you wish to concentrate on the To Do area and ignore (temporarily) the other 
areas of Time & Chaos, you can select To Do List Only from the Screen 
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Layouts under the View menu. This will provide an alternate layout for the 
entire Time & Chaos screen to display a focused view of your To Do data. It 
also continues to display a calendar for you in addition to the To Do List. When 
you are ready to return to normal, you can go back to the View menu and choose 
another Screen Layout, including the normal default layout. 

 

Adding or Editing Records 
There are a few different ways to create a new entry screen in the To Do area. If 
you are doing something for or calling someone in your Telephone Book, the 
easiest way to add an item is to find the correct name in the Telephone Book and 
drag and drop it down to the To Do window. When you drop it, Time & Chaos, 
by default, will make a new To Do item to call this person. If the default does 
not properly describe the task, you can double click on it to edit it. (You can also 
edit the default text in the Preferences if you would rather have a different 
default.) 

If you are entering a To Do item that does not need to be linked to a Telephone 
Book record, you can just use the Add button on the To Do window's toolbar.  

If you want to edit an existing To Do item, you can simply find it and double-
click on it to open the same entry/edit screen. 

In the Main section are the fields for Date To Begin Displaying, Priority Level, 
Description, Overlay and Linked Name. There is also a button for Attached 
Notes. 

Date To Begin Displaying is a specific date (i.e., day, month and year) on 
which the To Do Item will start being showing up on your To Do list. By 
default, the date is the same as the one selected on the main screen. If you want 
to change this date, you may type the desired date or you may click on the 
"down arrow" at the right end of this field and choose the new date on the drop-
down calendar. 

Priority Level is a place to rank the importance of a specific To Do Item. You 
may directly enter your desired value or you may click on the "down arrow" at 
the right end of the Priority data field to make your selection.  

Using the Priority field is very important because the ranking of its importance 
(such as A, B, or C) will determine the order in which the items are displayed on 
the main screen. The items of highest priority will be displayed first, followed in 
order by the items of lesser and lesser priority. 

Checking the Done box indicates to Time & Chaos that this task has been 
completed. This will also assign a specific priority ("X") to the To Do item. 
Until an item is completed, is will continue to show up on your To Do list unless 
you reschedule it or delete it. 

The Description of To Do item field is used to define the purpose of the To 
Do item.  

Note: If the description has an @ then a telephone number, you could also dial 
from this To Do item, if the need arose. 

You can organize your To Do items by using Overlay. You can define Overlay 
values and use them to classify specific To Do items. Examples of To Do 
Overlay values could be "Project X", "Personal" or "Business". Time & Chaos 
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maintains a reusable list of Overlay values that you have used. You may select 
from these by clicking on the "down arrow" at the end of this data field. 

If you wish to place a To Do in a specific Overlay, select it from your current 
list of To Do Overlays. Click on the "down arrow" at the right end of the 
Overlay data field and make your selection. If you wish to place a To Do in a 
new Overlay, enter the description of the new Overlay directly into the Overlay 
data field. New Overlay values entered are added to your current list of 
Overlays. 

Overlays can also be very useful in printing, because Overlays allow you to 
filter out other data from your calendars and reports. For example, you can make 
an Overlay for the tasks related to a particular project. If you choose to view just 
the Overlay you want instead of All on the Main screen, then choose to Print, 
you can produce a To Do list with just the information you want: a list of just 
tasks for your Project. 

 

To Do items can be directly associated with individual entries in your Telephone 
Book using the Linked Name field. By using this field to connect a To Do 
item to a Telephone Book record, you can build and maintain a complete 
Contact History for each person.  

If you drag a name from your Telephone Book and drop it into the To Do List 
Window, Time & Chaos will create a new To Do item and will automatically 
link it to the contact. If you entered the To Do on your own or imported it from 
another program, you can link the To Do manually by using the drop-down list 
in the Linked Name field to find the appropriate person or company. (The 
drop-down list will be sorted the same way the Telephone Book is sorted upon 
startup.) 

Once a To Do item is linked to a contact, Time & Chaos will display a  + in the 
"L" (for Linked) column. You will also be able to click on the To Do to 
highlight it and have the Telephone Book jump to the appropriate contact for 
you. 

 

The Attached Notes are a way to enter general information about a To Do 
item. They are entered in a special Note Editor screen that allows you to use 
"rich text". This includes the use of colors and fonts. There are also options to 
time-stamp your notes as you enter them so you can keep a chronological diary 
of entries in the notes. 

 

Category Settings allows you to give your To Do items special attributes, 
used within the To Do database for any special report needs you may have. You 
can click to the left of any box and type a label for any of the Category fields 
you wish to use. Once you have labeled your checkboxes, you can check all of 
the boxes that apply to this record.  

Later, you could use the Search screen to find all of the To Do items in 
particular Categories to give you more precise results.  

One example of how to use the Categories might be to list your business goals. 
As you enter To Do items, you use to Category Settings to indicate the goals that 
this To Do will help you achieve. In the future, you can create a custom report 
that shows all the To Do items in the one particular goal so that you know what 
you did to achieve it or perhaps the reasons you did not. 

Linked Name 

To Do Notes 

To Do Categories 
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More details about the use of Categories can be found in the Special Features 
section of this guide. 

 

To Do List Items are planned activities. Often our planned activities are repeated 
at definable time intervals. For example, you may have a "Progress Report" due 
on the first Monday of each month. 

Keep in mind, though, that you would only use the Repeat Options in the To Do 
area when you plan to complete an item and mark it as Done, but want to re-do 
the To Do item in the future. If you have an item which you have listed today 
that you do not plan to finish and want to be reminded to do it tomorrow, Time 
& Chaos will automatically roll each item you did not complete to the next day 
and the next and the next until you finally complete it! 

Time & Chaos allows the user to select a repeat period and specify a frequency 
at which this period is to be repeated. The To Do list item is then automatically 
repeated by Time & Chaos according to your specifications so that you do not 
have to enter each item individually. 

Periods that may be chosen include days, weeks, months and years. The desired 
frequency must be entered as a whole number. 

Let's look at one typical situation. You have a "Progress Report" due on the first 
Monday of each month. You wish to have Time & Chaos store this repeating To 
Do item for the next six months. Using the calendar area of the main screen, you 
would position yourself on the first Monday of the current month and create a 
new To Do item. 

During the data entry for the To Do item, click on Repeat Options on the left 
side of the entry screen then select a repeat period of "month(s)" with a 
frequency of "1". You would also specify a value for "Until the following date" 
such that the To Do item would be repeated for the next six months. Time & 
Chaos notes that you are repeating monthly and will allow you to check a box 
that specifies "The first Monday of each month" so that the To Do item will be 
repeated properly. If you did not check this box, the To Do item would be 
repeated monthly on that specific date. 

Time & Chaos will remember that this To Do is part of a repeating series. If you 
need to edit anything about the To Do details, you can edit just the current one. 
When you save the newly edited record, you will be asked if you want the same 
change to be made to all the future instances of that To Do as well. Similarly, 
when you delete an item that has been repeated, you will be asked if you want to 
remove the future instances of that To Do. 

 

Attached Files allow you to link documents, spreadsheets, pictures, or 
anything else on your PC to a particular To Do item. In the To Do item’s 
entry/edit screen, you can click on Attached Files on the left side of the 
entry/edit screen, then right click in this window to attach a new file. Once 
attached, an icon for it will appear. You can also drag a file itself and drop it in 
this window (if you can see both at the same time on your screen).  

Once items are listed here, you can double-click on any file and Time & Chaos 
will launch the necessary program to open the file you attached! The attached 
file list can also be viewed as a page of icons for your documents or as a detailed 
list. 

 

Repeat Options 

Attached Files 
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Completing To Do Items 
As you complete tasks on your To Do list, you can mark them as Done. To 
indicate completion, select the To Do item you finished and click on the Done 
button on the toolbar. You can also right click on the item and select Done from 
the popup menu or you can double-click on the item and check the Done 
checkbox. 

When you mark the item as Done, it will be "crossed out" on your main screen 
display. The item will also be permanently saved on this date, so it will be 
available for any reports or searches you perform in the future. 

 

Rescheduling To Do Items 
As things are always changing, it is likely that you will need to reschedule To 
Do items to a more appropriate date in order to meet your schedule demands. If 
so, there are a few easy ways to move items from one day to another. 

If you drag a To Do item from the To Do area and drop it on another day in the 
Calendar area, you will be given an option to move or copy that task to the new 
date. 

If you want to move the item to another month, you can always double-click on 
the specific To Do Item you wish to reschedule and simply edit the Date field to 
your new date. 

Time & Chaos also offers a special Screen Layout called the 12 Month 
Planner. You can select this by going to the View menu at the top of the 
screen, then to Screen Layouts, then to 12 Month Planner. This layout will 
provide a new window called YearView that will display the current and next 11 
months. Once the month is displayed that you want to move items to, you can 
drag and drop the To Do Item you want to reschedule to the new date. 

 

Printing with To Do items 
To print out a copy of the To Do items in your current Overlay, you can use the 
Print button on the To Do Toolbar, or right click in the To Do window and 
select Print on the popup menu. You will be given the option to print out a To 
Do List or a Day Plan. The Day Plan is a combination of your To Do list and 
Appointment Schedule for the given date. 

The To Do List printouts are comprehensive, which means that if you print out a 
list for a day on next week, the items listed will be all of your current items 
along with all the items between now and the future date. If you are leaving on a 
trip and need to take a printout of your To Do items with you, you will only 
need to print out one To Do list. 

Once you select the report you wish to print, you will be taken to the Print 
Preview screen where you can adapt the layout and report options to your needs. 
Please see the chapter on Printing for details on this area if you need more 
information. 

In addition to these standard print jobs, remember that you can always use the 
Search and Report screen to generate your own custom To Do report. You can 
choose the fields you wish to include and choose a range of dates you wish to 
report on. This can also print a To Do report with items only on specific dates, 
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rather than being a comprehensive list of all items not yet completed. A chapter 
on using Search and Report can be found later in this User's Guide. 
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Chapter 4: The Calendar 

The Calendar Display Window 
The Calendar gives you a view of the entire month's date-related data. It is not 
used for data entry, since it is entered in the Appointment and in the To Do 
areas. The Calendar, however, gives you some important and valuable features 
that can help you view and work with your schedule. 

The main screen of Time & Chaos has the Calendar in the upper left corner. All 
that is visible are the day numbers. A day number in black text is a day for 
which nothing is scheduled. If a day is displayed in a color, then there is at least 
one appointment scheduled on that day.  

You do have a degree of control over the color that is displayed in the calendar. 
By default, if you have an appointment, the day color on the calendar will be 
red. However, in the Appointment area, you can set a specific Item Color for 
each Appointment. If the very first Appointment on any given day has a color 
other than red, the Calendar will show the same color as this first Appointment. 

Using colors can be useful to help determine when certain types of events occur. 
For example, you may set the colors for all vacation days to blue so that you can 
see them easily on the calendar. 
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Navigating the Calendar 
Selecting a day on the Calendar will affect the information displayed for the 
Appointments and To Do list. To change from day to day within a month, 
simply click on a different day in the Calendar window. 

If you want to change the month you are viewing, there are quite a few options 
available to you, depending on what you find easiest. At the top of the Calendar 
is a toolbar with Last Year, Last Month, Today, Next Month, and Next 
Year buttons. After the Next Year button is a Go To button, which will allow 
you to move directly to a specific date. If you want to change directly to another 
month, you can click on the Month Name to select from a list of all twelve 
months. You can also click on the year to select another year, if desired. 

 

Display Options 
There are a few options you can control to affect the Calendar display. 

If you right click in the Calendar area to bring up the popup menu, there is an 
option to show Leading/Trailing Dates. Normally, the calendar will display 
only the day numbers for the current month. If you are viewing November, only 
30 days will have numbers in them and the others will be blank.  

If you select Leading/Trailing Dates, then the blank boxes will be filled in with 
the days from the previous month and next month. You can also click on these 
days to view the appropriate Appointment and To Do data for them. 

The top of the Calendar area shows the Day Number by default. This number 
counts from Day 1 (January 1) to Day 365 (December 31). Using the popup 
menu, you have an option to view the Week Number instead of the Day 
Number.  

Different regions, countries, and organizations define Week Numbers 
differently, but Time & Chaos supports all of the standard ways of defining a 
Week Number. There are three known ways to measure this: First Week 
begins on January 1, First Week contains at least four days, and 
First Week begins with first full week. If you want to use Week Numbers, 
just choose whichever method is appropriate, and it will replace the Day 
Number. If you unselect the Week Number choice later, the display will return 
to displaying the Day Number again. 

 

Month View and Week View 
If you use the Maximize Window button in the calendar area, the calendar will 
fill the entire Time & Chaos window in a Month View mode. 

Month View allows you to see the Appointments or To Do items you have 
scheduled for the entire month, rather than just a day at a time like the main 
screen shows. The very top of the Month View screen is where you can select 
Appointments or To Do items to be displayed. 

If you double-click on a day in a particular week, the Month View will turn into 
a Week View to allow you to focus on the smaller period. 
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YearView and 12 Month Planner 
Layout 
If your focus is on a long-term basis, there is also a way to display twelve 
months of calendars in a special alternate layout. To see this, use the Screen 
Layout option under the View menu at the top of the main screen, and choose 
to view the 12 Month Planner Layout. 

As a result, the left side of the screen will display a column of twelve calendars, 
starting with the current month. On the right side, your appointments and to do 
items will be displayed as well. 

This particular Screen Layout is perfect for long term scheduling and it allows 
you to reschedule any existing items by simply dragging and dropping the item 
onto a new date in the YearView window. 
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Chapter 5: Printing 

The Print Preview screen 
It is safe to say that at some point, you will want to take the data you have 
labored to enter in Time & Chaos and print it out to paper. If so, you can take 
advantage of the powerful print options available to you from our Print Preview 
screen. 

The Print Preview screen will allow you to see what you are about to print in 
order to ensure that it will appear just as you intend. A customization window 
opens to the right of the preview images with all of the options available to 
tweak the output for your special needs. As you will see, we have options 
available for almost anything you would want to change. 

 
 

Print Customization window 
The Device tab shows both Printer options and Paper options. The Printer 
options allow you to select a printer as well as to set some printer-specific 

Device 
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options such as Print Quality, Duplex mode and Number of Copies. The Paper 
options allow you to change the Paper Size as well as the Source.  

 

The Layout tab provides you control over the placement of information on your 
page. Your Orientation options (Portrait or Landscape) and your Margins 
settings (Left, Right, Top and Bottom) can be found here. 

You can also control the Page Borders, Table Borders, Text Alignment and the 
number of Columns to split the data into, where applicable. 

The Scaling option allows you to choose one of two special paper formats for 
your printout. Time & Chaos will print on special supported papers including 
DayTimer© and Avery© products. For most normal reports, you can choose 
between two types of DayTimer paper, a Junior size (5½ x 8½) and a Pocket 
size (3¾ x 6¾). Using Scaling is great even when using normal paper, because 
you can print out much more information on a page.  

The most popular scaling option is the (5½ x 8½) option. This Scaling choice 
will print out two pages of information side by side on the same sheet of paper, 
reduced to fit. 

 

On the Fonts tab, you can select or change the desired printer font and font sizes 
to be used for the heading, the body and the footer of the report.  

Using TrueType fonts is always suggested because of their scalability. 

You can also change the text used for the Heading and the Footer, if desired. 
The default text for the Footer should say something like “Page %d || Printed on 
%DATE%” which will print the page number and the date of printing at the 
bottom of each page. 

 

The customization options on the Addressing tab might be used for Envelopes 
or for Mailing Labels.  

Here is a table with each option, its purpose, and which type of printout it is 
applicable to: 

Addressing 
Option 

Purpose Applicable 
To 

Send To Address Allows you to temporarily edit the 
address you will be sending to. For 
permanent changes to the address, you 
would need to edit the record directly. 

Envelopes, 
Mailing Labels 

Mail Label Style Provides a list of Avery Mailing Label 
types to select from. 

Mailing Labels 

Return Address Allows you to choose to include a return 
address and choose which return address 
to include. Return Address setup is found 
on the Main Screen by going to File, then 
Preferences 

Envelopes 

Display Mailing 
Label Grid 

Controls whether lines appear on your 
printout which separate the addresses 

Mailing Labels 

Layout 

Fonts & Header 

Addressing 
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Addressing 
Option 

Purpose Applicable 
To 

Sort By 
ZIP/Postal Code 

Allows addresses to be arranged in ZIP 
code order rather than the normal order of 
Company or Last Name 

Mailing Labels 

Include 
Company Names 

Controls whether the Company Name is 
included with the address 

Mailing Labels 

Use Secondary 
Addresses 

Forces the use of the Secondary Address 
on Envelopes and Mailing Labels rather 
than the Primary Address 

Envelopes, 
Mailing Labels 

Include Job Title Controls whether the Job Title 
information will appear as part of the 
Send To address 

Envelopes, 
Mailing Labels 

Use Postal Bar 
Code 

Controls whether US Postal Service bar 
codes appear 

Envelopes 

Nudge Amount Provides extra control of the placement of 
addresses. This is somewhat similar to 
margins, but instead of affecting the page 
layout, it moves the address around the 
page.  

Envelopes, 
Mailing Labels 

 

The Tweaks tab provides many special output options to give you extra control 
over each printed report. Some options will be disabled if they do not apply to 
the type of report you are about to print.  

Here is a table of all the Tweak Options available, what each option does, and 
which reports they apply to: 

Tweak 
Option 

Purpose Applicable To 

Color of table 
headings 

For users with color printers this 
provides a choice of heading colors. 

All printouts 

Number of 
Calendar 
Periods 

Controls how many time periods are 
printed. For example, if printing 
monthly calendars, setting this value to 
12 would give you 12 months of 
calendars printed at one time. 

Monthly Calendars, 
Weekly Calendars, 
Daily Calendars 

Use Monthly 
Calendar 
Headers 

Controls whether the mini-calendars 
for the current month and next month 
appear at the top of the report 

Weekly Calendars, 
Daily Calendars, To 
Do Lists, DayPlans 

Use 
Appointment 
End Times 

Controls whether the end times of 
appointments are displayed 

Monthly Calendars 

Use Double 
Spacing 

Controls whether appointments are 
single or double-spaced 

Monthly Calendars 

AutoSize 
Calendar 

Allows cells to expand or contract, 
based on content to be printed 

Monthly Calendars, 
Weekly Calendars 

Use Time Line 
Calendar 
Display 

Will print Appointments in a time line 
format rather than just chronologically. 

DayPlans 

Tweaks 
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Tweak 
Option 

Purpose Applicable To 

Alphabetic 
Page Breaks 

Forces names starting with each letter 
of the alphabet to be printed on 
separate pages. This is especially 
useful if you are printing for use in a 
day-planner book with tabs for each 
letter 

Telephone Books 
and Address Books 

Block Lettering Controls whether the Send To address 
appears entirely in Capital Letters, as 
requested by the US Postal Service 

Envelopes, Mailing 
Labels 

Block Lettering Controls whether contact and company 
name appear in Capital Letters 

Telephone Books, 
Address Books 

Include Custom 
Fields Section 

Controls whether Telephone Custom 
Fields appear on contact profiles 

Contact Profiles 

Include 
Categories 
Section 

Controls whether Telephone category 
information appears on report 

Contact Profiles 

Include Notes Controls whether all information in the 
Notes area appears on the report 

Contact Profiles, To 
Do Lists 

Include 
Appointments 

Controls whether a complete list of 
Linked Appointments appears on a 
contact profile 

Contact Profiles 

Include ToDo’s Controls whether a complete list of 
Linked To Do items appear on a 
contact profile 

Contact Profiles 

Use metric 
measurements 

Allows Margin options and Nudge 
options to be set in metric terms rather 
than English measurements 

All printouts 

 

Clicking the Apply button will instruct Time & Chaos to implement all of the 
changes you have made in your setup option. After clicking on Apply, your 
changes should be reflected both in the print preview area and on your actual 
printed output. 

The Reset button will restore the "factory defaults" for the current report. If 
you’ve made a lot of changes and aren’t sure how to get things back to normal, 
the Reset button might be a good place to start. 

The Save button instructs Time & Chaos to store all of the output format 
choices that you have specified for the current report. 

When you save your customized print settings, this includes the choice of a 
specific printer and its properties as well as the various layout, font and 
tweaking choices. When you print the same type of report again, these settings 
will be used automatically. Each type of reports can have its own settings, as 
well. 

 

Apply Reset and Save 
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Print Toolbar 
The Print Toolbar is where you can resize the preview image you are viewing 
and finally print out the report to paper. 

 

Any printouts in Time & Chaos can also be used to generate HTML pages for 
web viewing in addition to normal paper output. If you wish to publish your 
telephone book, calendars, or anything else, just use the File menu of the print 
screen and choose Save As HTML Page. You will have an opportunity to 
choose a name and location for the .html file.  

You can also view the results of this publishing capability with the option to 
Open HTML Page. This will open your default web browser and display the 
results for you. 

In addition to using these .HTML files for your Web site, this format is also 
something you could attach to an email to deliver your information to a non-
Time & Chaos user. 

Print All and Print Page let you print the entire document or just the current 
page you are previewing. 

Clicking on Setup will open or close the print customization window, which 
lets you change your print options. 

 

Show Layout Guides lets you toggle off and on the extra lines on the print 
preview screen that show you the margins for the heading, body and footer, as 
well as the printable region on your page with this printer. These lines never 
print out, but can be used as a guide to understand how and why things are 
printing as they are.  

Copy Page will take a snapshot of the preview image and put it on your 
Windows clipboard, allowing you to paste it as a graphic into another 
application, such as Microsoft Word. 

First Page, Last Page, Next Page, and Previous Page allow you to 
navigate between pages on large reports. 

 

The Print All button tells Time & Chaos to send all pages of the formatted 
report (being previewed) to the currently selected printer. 

The Print Page button tells Time & Chaos to send the present page of the 
formatted report (being previewed) to the currently selected printer. 

The arrow buttons allow you to navigate through your previewed report if you 
have multiple pages. In order the buttons are First Page, Previous Page, then a 
display of the current page number, then buttons for Next Page and Last Page. 

The Zoom Percentage allows you to control the magnification of the preview 
image. The user selects the desired magnification factor from a list of available 
display percentages (i.e., 30, 50, 75, 100, 150 and 200). 

Close instructs Time & Chaos to exit the print preview display. You can also 
use the X button at the top right of the window to exit. 

 

File menu 

View menu 

Toolbar buttons 
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Print Preview Image 
Double-clicking on the Preview Image will zoom in and out: left for in, right for 
out. 

The image shown is exactly what will be sent to your printer. If this does not 
currently look like the output you desire, then you know to use the Printer 
options to setup your report and correct the output. 

As mentioned before, you must remember to apply the changes you make in the 
Print Options area. When you apply them, the Print Preview Image will be 
updated to reflect your changes. 
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Chapter 6: Search and Report 

Understanding the Search Screen 
Using the Search and Report screen in Time & Chaos will allow you to search 
for particular records, to create custom reports, to mail merge, to edit groups of 
records, or "filter" your phone book on anything you can search for. Wow! With 
that list of features, it will be worth the effort to understand the Search and 
Report screen and learn how to make it work for you. 

You can get to the Search and Report screen in a few different ways. The easiest 
is to look for the Search button on the toolbar of each area. If you can’t find the 
button on the toolbar, you can use the right button on your mouse to right-click 
in any window to see a pop-up menu of options including Search and Report. 

As you look at the Search and Report Screen, it can really be broken down into 
two main areas. The top of the screen is the Search area that allows you to 
specify what you are looking for and to perform the search. The bottom part is 
the Report area. Many columns are displayed, each set to a specific field of 
information. Once you have completed a search, your results will show up much 
like a spreadsheet, with each column showing a field and each row being a 
different record on your results. 
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Doing a Search 
You can add all the fields you desire to your Search results by editing as many 
column headings as you need 

Sometimes, whether you are creating a custom report or attempting to perform a 
mass-update of your records, you need to control the fields that will appear on 
your search results. 

Once the Search screen opens, you should make sure you have the right database 
open. The current database will be seen on the title bar of the window (i.e. 
Telephone Book Search). In the top right of the Search and Report screen, there 
are buttons for the Telephone Book, To Do List and Appointment databases, if 
you need to switch. The Search and Report screen can only work with one data 
area at a time. 

When the search screen first opens, there are basic fields selected for you, 
shown as column headers. For a Telephone Book Search, the default fields are 
Last Name, First Name, and Company Name. If you want to add more fields of 
information to your search results, you can just edit the column headings.  

When you click on a column heading, you will be provided with a list of all 
available fields in that data area. Just select the field you want and it will be 
added to your results. There are plenty of columns available, so you can add as 
many fields of information as you like by simply setting up the column 
headings. 

The columns you select will then be filled with the appropriate data when you 
execute your search. Instead of getting results with just Last Name, First Name 
and Company Name, you can include Overlays, Phone Numbers, Addresses, 
Notes, and any other information you have stored inside the Time & Chaos 
Telephone Book. 

Setting up the columns with the particular fields you want will allow you to print 
a customized report showing the fields that you asked for and found on the 
Search and Report screen. Setting up fields are also important for editing, as the 
editing options will only change data in the results of your search. For example, 
if you want to edit the Overlay for a group of records, you have to setup a 
column for the Overlay field before doing your search. 

 

Once you have chosen the fields you want to appear on your results, you can 
specify your search criteria. 

The top part of the screen gives you fields where you can indicate your search 
criteria. 

Note: You can click on Find Now without specifying any search criteria to find 
all records in your database 

The Search Field is where you can specify a particular field to look in. There 
is a drop down list of the available fields in the database you are searching. If 
you leave this set to All Fields, then Time & Chaos will look in each field, 
including the Notes area, to find a match for your Search Value. 

Next to Search Field is the Search Logic field. The default is a "Contains" 
search, but there are other Logic options available to you as well. The full list of 
choices includes contains, equals (=), greater than (<), less than (>), not equal to 

Step 1: Selecting 
Fields for Results 

Step 2: Specifying 
Search Criteria 
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(<>), or between. If you choose between, then you will see a second value field 
so that you can define your full search range. 

The Search For… field is where you can tell Time & Chaos for what you are 
searching. If you are searching in a date field, you will be provided with a drop-
down calendar to select your search value. If you are searching Overlays or 
Categories, you will be provided with a list of choices. If you are searching any 
other field, you can simply type it into the Search For… field. 

Under Search For… is a field called Maximum Field Value. This field is 
normally disabled unless your search logic allows it, such as with a between 
search. 

 

Once you have specified the fields you want by setting up the columns and you 
have defined your search criteria, you can then click on the Find Now button. 
This will execute your report, find the records that meet your criteria, and 
display the columns of information you requested. 

Sometimes, you may want to further narrow down your search results into a 
smaller group. If so, you should notice that after you have completed a search, 
the Find Now button now says Find Subset. If you specify some new criteria 
and click the Find Subset button, the Search and Report engine will search just 
your previous results to find those that also match the new criteria. 

Your results can be sorted by any of the columns that are visible. The quickest 
way to sort is to simply click on the column heading of one of the columns. For 
more advanced control of sorting options, you can click on the Edit menu at the 
top of the screen, then choose Sorting. You can select up to three columns in 
order of priority that you wish to sort in ascending or descending order. 

The results you see will show each of the columns you asked for in Step 1: 
Selecting Fields for Results. However, if you want to add a field you forgot or 
remove one you don’t need to see, you can use your right mouse button to right-
click on a column heading to add a New Column or to Remove Column. 

If you are planning to Print out your search results as a customized report, you 
can change the column labels at this point, if desired. Just right-click on a 
column heading you wish to modify and choose Rename Header. 

If you want to start over with a clean search screen, either due to a user error or 
to move on to another search, you can just click on the New Search button. 
The Search and Report screen will then be reset. This way, you won't have to 
close and reopen this screen. 

When you are finished with the Search and Report screen and are ready to return 
to the main screen, you can click on the Close button to exit Search and Report. 

 

If you have gone through the trouble of setting up a customized report with your 
selected fields, you may want to save your report so that it can be run at any 
time without doing all the report setup again. 

If so, then once you have executed a search, you can use the File menu at the top 
of the Search and Report Screen. You will find an option to Save Report 
Format, where you can supply a name for your report. 

In the future, if you wish to run this report again, you can go directly to the File 
menu and choose to Open Report Format. Once you select a saved report, it 
will immediately execute and give you the current search results. 

Step 3: Performing 
the Search 

Step 4: Saving Your 
Reports 
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Customizing the Search Screen 
Each time you open the search screen, you will find that Time & Chaos has pre-
selected some popular columns for you. For example, in the Telephone Book 
Search Screen the First Name, Last Name and Company Name are predefined 
columns. 

If you find that you are always adding other columns to your search results each 
time you use this area, Time & Chaos will allow you to create your own 
Default Column Layout. Set up the columns YOU want first, then go to the 
File menu and choose Default Column Layout. With your approval, Time & 
Chaos will now remember these fields as the ones you wish to start with the next 
time you use this search screen! 

 

Once a search is complete and results are visible, you can click on any column 
heading to sort by that field. If, however, you need to use multi-level sorting, 
you can go to the Edit menu on the Search screen and click on Sorting… to 
gain some special sort options. 

Multi-level sorting allows you to tell us different columns you wish to sort by, in 
the order you want them to be applied. 

 

This section of Time & Chaos is called the Search and Report screen because it 
can generate customized Reports for you to print out, with the fields and 
information you selected. 

As a tweak to your report, you can modify the labels on any column, instead of 
leaving it just as the field name. After your search is complete, right-click on a 
column heading you wish to modify and choose Rename Header to type a 
new temporary name this column. 

One last option for you before printing your report is the column widths. When 
Time & Chaos does the search, the columns are auto-sized to fit and display the 
actual data for each field. Once the search is complete, you can click and drag 
the column borders to the left or to the right to resize the columns according to 
your own needs and desires. The column widths you set here will be in effect 
when you move on to the Printing step. 

By the way, there is also an option under the Edit menu for Word Wrap which, 
if enabled, will allow your information to scroll onto a second line if the column 
width is shortened. 

 

Exporting data 
Once you have found the information you are seeking, you can take advantage 
of the many Create options we have available to utilize or transfer the data. 
These options include vCards, ASCII delimited files, mail merges to your word 
processor, Microsoft Excel spreadsheets or Lotus WKS files, Transportable 
Records, Outlook Express Import File, and support for the Sharp Wizard 5500 
and Timex DataLink devices. 

However, it is vital that you remember to select or highlight the items you wish 
to base your creation on. The most common mistake made when exporting is 

Default Column 
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Multi-Level Sorting 

Report Tweaks 
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users forgetting to select any items first. When you create an ASCII file or do a 
mail merge, only the highlighted records will come out on the other end. 

Note: If you wish to select all the items you found in your search results, you 
can click on the Edit menu and then click on Select All to highlight everything 
you found. 

 

The vCard format is an emerging standard for transferring data between many 
different Information Manager programs. If you wish to create vCards for 
records in your database, you can search for the records, select them, and use the 
Create, vCard File(s) option to produce the desired .VCF files. You will be 
prompted for the directory where you wish to create the .VCF files, as well. 

Note: vCards apply only to the Telephone Book database, because this is the 
only type of data addressed by the vCard standards. 

 

ASCII comma delimited files are a standard format for transferring data from 
one database to another. When you choose to create an ASCII delimited file, 
you will be provided an additional option to either include All Exportable Fields 
or Only Fields In Search Results. If you select the latter, then only the columns 
of information you set up will be exported. If you select all exportable fields, 
then Time & Chaos will export all the data it can, regardless of whether or not 
you setup a column for each field. 

 

You can use the results of a Telephone Book search to become a data source for 
a Mail Merge using your chosen word processor. For complete details on Mail 
Merges, please consult the section in Special Features on Mail Merging. 

 

If you have Microsoft Excel, Time & Chaos can launch Excel, take the results of 
your search and automatically transfer all the columns and data to a new Excel 
spreadsheet. 

Once inside Excel, you can perform advanced manipulation of your results, or 
even save the data in any format that Excel supports, such as dBase or .dbf . 

Note: This feature requires Microsoft Excel 95 or newer 

 

If you use Outlook Express as your email package, you may find it useful to add 
your data from Time & Chaos to the Outlook Express address book. Search for 
and highlight all the names in your telephone book that you wish to export and 
then select this option to create a file that can easily be brought into and 
imported into the Outlook Express address book.  

Please note that this will only export names that actually have email addresses! 
This feature is also specifically for Outlook Express users and may not apply to 
Microsoft Outlook (a completely different product with a similar name) 
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This option does not launch Lotus, but will simply build a Lotus .WKS file that 
is a simple spreadsheet format. This is a standard format supported by most 
spreadsheet programs, so if you are using something other than Excel, this might 
be the best option for you to transfer your search results. 

 

Built into Time & Chaos is the ability to package a group of data for transfer to 
another database, either on your machine or on someone else's. Building a 
Transportable Record will create a file with an extension of .IXP (iSBiSTER 
Exchange Package) that you can attach to an email or post on a web site, if need 
be. Full instructions on using Transportable Records can be found in the Special 
Features chapter. 

 

Time & Chaos supports the Timex DataLink system for transfer of your data to 
devices such as the Timex DataLink watches and the Royal FL95 Organizer. For 
this to work properly, you must have version 2 of the Timex DataLink software. 

Once you choose to create a Timex DataLink File, you will need to specify the 
DAT directory of your Timex DataLink software, and make the appropriate data 
file there. After this is complete for each of the databases you want to transfer 
from (Appointments, To Do items and/or Telephone Books), you can then start 
up your DataLink software. There, you will see all of the information you 
exported from Time & Chaos, and you can use the Timex DataLink Software 
from this point to transfer the data to your device. 

 

This option will allow you to export Appointments, To Do items or Telephone 
entries into model 5500 of the Sharp Wizard Organizer, a device available 
around 1995-1996. A linking product to allow the transfer of data between a PC 
and this specific Organizer was available directly from Sharp. 

The Sharp Wizard provides three applications (compatible with Time & Chaos) 
for its users, Schedule, ToDo and Telephone.  The Schedule application can 
import data into a single file known to it as SCHEDULE. Time & Chaos will 
export data to a file of the user's choice with a default name of SCHD.CSV. The 
ToDo application can import data into a single file known to it as TODO. Time 
& Chaos will export data to a file of the user's choice with a default name of 
TODO.CSV. The Telephone application can import data into one of three files 
known to it as TEL1, TEL2 and TEL3. TEL1 is actually known to the Wizard 
user as Telephone. TEL2 is actually known to the Wizard user as Contact. TEL3 
is actually known to the Wizard user as Personal. Time & Chaos will export data 
to files of the user's choice with default names of TEL1.CSV, TEL2.CSV and 
TEL3.CSV. 

 

Sometimes you may wish to work with a select group of names in the Telephone 
Book area on the main screen, but you don't want to make a new Overlay for 
this "temporary" group. If so, you can simply do your search for the names in 
the Search and Report Screen, then use the Custom Phone List on Main 
Screen option to create a temporary custom phone list. You will receive a 
message stating that the items were transferred. You can then return to the main 
screen, where you should find the Telephone Book is now displaying just the 
Custom Phone List that is based on your search results. 

When you are ready to go back to your normal Telephone list, you can change 
the Overlay option to All or to any other Overlay. 
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Chapter 7: Special Features 

Overlays and Categories 
As you start to get more and more information in your databases, Overlays and 
Categories can help you manage your data and organize it into logical groups. 
Time & Chaos offers these two different ways to organize your data because 
using Overlays and Categories each have advantages, depending on what you 
need to accomplish. 

 

Overlays are available to you in all of the data areas: the Appointments, To Do 
List, and Telephone Book. The Overlay field is just a text field on the Edit/Entry 
screen where you can select an Overlay from drop-down list or type something 
new (up to 15 characters) to create a new Overlay. 

For example, when using Overlays in the Telephone Book section, some users 
create an Overlay for White Pages to indicate their personal contacts and Yellow 
Pages to indicate their work contacts. Other users might use different labels such 
as Prospects, Clients, or Friends. 

Each record can only have one Overlay, but you can create as many new 
Overlays as you need to – Time & Chaos does not set any limits on the number 
of Overlays. The Overlay field is also optimized for performance: you can 
quickly change between Overlays on your main screen without a long wait for a 
search to finish. 

Once your records have Overlays, you can use them to "filter" your data. You 
can select among your different groups by using the Overlay button on the 
toolbar in any of the data areas of Time & Chaos. 

The Overlay list will give you an option to view All records, to view just the 
records in one particular Overlay, or to view the Unfiled records for which you 
did not indicate a particular Overlay. 

Printing is also affected by the use of Overlay filters. While the main screen 
display is filtered by an Overlay, printing a Phone Book or an Address Book 
will print only those records in the Overlay rather than your normal complete 
list. 

 

If you want to remove an Overlay, you just need to edit any of the exiting 
records that use the Overlay you want to remove and change the Overlay field to 

Overlays 

Overlay Tips and Tricks 
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something new.  As soon as the Overlay you wish to remove is no longer used, it 
will automatically disappear from your list of Overlays. 

In the Telephone Book, the using the name of a color in your Overlay name will 
also make the background of the Phone Book change to that color when you 
choose to view that Overlay. The colors that Time & Chaos will recognize are 
blue, green, cyan, red, magenta, yellow, and white. 

If you share a database with other users, the Overlay field can be used to identify 
ownership. If all of your appointments have your name as the Overlay, you can 
filter out the calendar to show just your items instead of having them mixed with 
everyone else’s. 

If you want to change the Overlay value for an entire group of records, you can 
use the Global Replace feature of the Search and Report screen. You can search 
for a group of records, then use Global Replace to make a change to each of 
their Overlays without having to edit each record individually. Please see the 
section on Global Replace for more information on the exact steps to make this 
happen. 

 

Each area of Time & Chaos will let you create and use Category Settings to 
define special attributes of each record you enter. With Categories, you will 
have a quick way to find records later that meet your special criteria and have 
the attributes you are looking for. 

For example, if you were a car salesman, you would want to enter your 
prospective buyers and current clients into your Telephone Book. The Overlay 
feature in Time & Chaos would let you define your Prospects or Clients, but 
each prospect or client might not be interested in the same types of cars. Some 
will want Sports Cars; others are interested in Trucks, Sport Utility Vehicles, 
Mini-vans, or Sedans.  

With Categories, you can create checkboxes for each type of vehicle you sell 
and for each person, check all the boxes that are appropriate. Later, when you 
have a special deal on Sedans, you can search for everyone in the Sedan 
category and find the target group you really need without getting all the 
Prospects or Clients that aren’t interested in that type of car. 

When you add or edit a record, there is an option on the left for Category 
Settings. This section will provide you a screen full of checkboxes to set and 
control your Categories. 

Each record can be in as many Categories as you want. You just need to check 
all the boxes in the Category Settings that are appropriate.  

If you need to make a new Category, just click with your mouse to the right of 
an unlabeled checkbox and Time & Chaos will let you type a new label right on 
the Category Settings screen. 

Once you have established Categories, you can use the Search and Report screen 
to search for records with particular boxes checked to help with mail merges or 
specialized reports. 

The main screen of Time & Chaos also offers a Category Filter button that will 
allow you to filter the Telephone Book or Appointments area by your Category 
Selections. 

 

The Category Filter screen allows you to search for and filter by Categories 
without using the Search and Report screen. This feature is available in the 
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Telephone Book and the Appointments area. On the toolbar for each of these 
areas, you should find a Category Filter button to open this screen. 

The Category Filter button looks like this:   

Once the Category Filter screen opens, you will see a list of all of your 
Categories to select from on the left side of the screen. You can check any boxes 
that apply to what you are looking for. 

On the right side, there is a box labeled Searching with choices for And Logic, 
Or Logic, or Not Logic. 

And Logic will look only for records that have checkmarks in each and every 
box you selected. For example, if you are looking for Sports Cars AND Sedans, 
if a record has Sports Cars checked, but not Sedans, it will not show up on your 
filtered list using And Logic. 

Or Logic will find any records that have at least one of the boxes checked that 
you are looking for. This option will cast a wider net than the And Logic option, 
since a record will only need to meet one of your search criteria to show up on 
the filter list using Or Logic. 

Not Logic will filter your display to show everyone but the single checkbox 
you selected. 

 

 

In the Telephone Book section, the Category Filter screen provides Editing 
options to set or clear a particular Category for an entire group of records. 
Highlight a group of names in the Telephone Book, and then click on the 
Category Filter button. Choose the appropriate Category on the left side of the 
screen and then choose to Set Categories or Clear Categories on the right side of 
the screen. Click OK and Time & Chaos will modify all of the selected records 
at once. 

Category Tips and 
Tricks 
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Time & Chaos will also allow you control how many Categories you have 
available. Open a record, click on the Category Settings option on the left and 
then press the F7 key. A window will open to let you set the number of 
Categories in this data area to any number between 10 and 250. 

 

Overlays and Categories are both used to organize your data, but they do this in 
very different ways. 

Each record can only be in one Overlay at a time, but there is no limit to how 
many Overlays you can create. With Categories, there is a limited number of 
Categories available, but you can put a record in many different categories at the 
same time. 

Overlays are optimized for speed, so you can quickly filter the display of any 
area on the main screen of Time & Chaos to show just the items in one 
particular Overlay rather than the complete database. A Category Filter requires 
much more time and is primarily used in the Search and Report screen when 
searching for particular groups of information. There is also a Category Filter 
button on the main screen in the Telephone Book and Appointment areas, but 
this will not perform as quickly as Overlays can. 

 

Letters and Mail Merging 
One important reason to use a PC-based information manager like Time & 
Chaos is to quickly generate professional letters, personalized for each contact. 
Time & Chaos is capable of using the power of Microsoft Word (95 or newer) 
and Corel WordPerfect 2000 to design, merge and print documents of your 
design to meet your specialized needs. 

There are a few steps to every mail merge when you use Time & Chaos as a data 
source. These steps are: 
1. Select the people in Time & Chaos you want to send to 
2. Create a Template customized with the fields from Time & Chaos 
3. Merge the names with the template to get ready-to-print output 

Note: If you only need a single contact's name and address at the top of a new 
blank document, you don’t need to use the mail-merge feature. Instead, just 
select the person in your telephone book, click on the Word Processor button on 
the Telephone Book toolbar and select New Letter. 

 

You can select the records you want to merge on either the main screen or the 
search screen.  

On the main screen, you can highlight one or more people, then click the Word 
button on your Telephone Book toolbar. If you want to select multiple people, 
keep in mind that Time & Chaos supports Shift-Click and Control-Click to 
highlight items in a list, just as many other Windows applications do. 

If you want to mail merge to a group of people, you may find it easier to use the 
Search and Report screen. You can use the search criteria of the Search and 
Report screen to find all the records you want to mail merge to, then use the Edit 
menu and Select All to highlight them. On the File menu, choose Create, and 
find your word processor on the menu. 

Differences between 
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Once you have names selected, on the main screen or search screen, you can 
then create a template to use for your mail merge. 

 

With one or more contacts in your Telephone Book selected, you can click the 
Word button or menu option and Create a New Template. When you Create 
a New Template, you will have to 
1. Choose a type of Template. You can make a Letter Template, an 

Envelope Template, or (for users of Word 97 or newer) a Catalogue 
Template.  

2. Name your Template. Once you select the type of Template you wish to 
build, you will be asked for a name for the new Template you are building. 
You don’t need to type a file extension, as Time & Chaos will add that 
automatically. 

3. Select Template, if desired. (Only for Word users!) Most of the time, 
you would just click on Cancel so that Word will give a blank new 
document to start with. However, if you want to create a modified version 
of a previous template you made, you can browse for it here. Our templates, 
by the way, are usually stored in your data folder location. Advanced Word 
users might also want to use a pre-made Word template for letterhead or fax 
cover sheets and personalize them for use with Time & Chaos. If so, you 
can select a Word template with this option, as well. 

Once in your word processor, you will be placed in a mail merge mode with a 
special toolbar at the top. Time & Chaos provides all of the usable Phone Book 
fields to Word and WordPerfect so that you can insert them as needed into your 
document. 

As you create your Template, you can use the Insert Merge Field button on the 
word processor’s toolbar to place a field code or merge code wherever you want 
Time & Chaos to supply data. For the body and signature of the letter, you 
should just type it as you normally would. 

Keep in mind that you are responsible for all punctuation and spaces when you 
are creating this Template. For example, don't forget to type a space between the 
first name and last name fields, or you will get something like JohnSmith on 
your merged output. 

When your Template is complete, you might have something that looks like this: 
January 1, 2001 
 
«FirstName» «LastName» 
«Company» 
«PriAddr1» 
«PriAddr2» 
«PriCity», «PriState» «PriZipCode» 
 
Dear «FirstName», 

After you have designed your new Template, be sure to Save it (not save as, but 
save) so that all your hard work in creating the Template is retained. Now that 
you have created a template, you must Exit your word processor and return to 
Time & Chaos before you can merge to your template. 

 

Once you have created a new Template and you have selected the names you 
want, you can use the word processor menu to select the Merge to Template 
option. You will be given an opportunity to find the Template you built through 

Step 2: Create a 
Template 
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Time & Chaos. You can select from a list of recently used Templates, or you 
can browse for a different one. 

After choosing your Template, your word processor will immediately merge all 
the records you selected in Time & Chaos with the Template to make your final, 
printable document. 

If everything is correct, you can use the Print feature in your word processor and 
you’re finished! 

 

If you want to make changes or corrections to a Template that you’ve already 
created, there are some easy steps to follow to change a template without 
damaging it. 

First, select a name from your main Telephone Book, click the Word button and 
Merge to the Template you want to edit or modify, even though the merged 
output will not be what you want. 

Once the merge is complete, open the Window menu at the top of the Word 
screen. On the Window menu, you should see the output document (Form 
Letters 1) and your Template. 

If you select your Template from the Window menu, your word processor will 
show you the Template as you originally designed it. You can now make the 
needed changes. When you have finished, Save the document and close Word 
before trying to merge to this Template again. 

IMPORTANT: Do NOT use the Save As option in Word to save your template 
under a different name. A template created with a Save As will not merge 
properly from Time & Chaos because of the “behind-the-scenes” settings that 
make this feature work. If you want to make a new template that is based on an 
existing one, you should instead choose the New Template option and browse 
for the existing template when you get to the window to Select Template, if 
desired. 

 

Editing Groups of Data 
Time & Chaos has some special options available as part of the Search and 
Report screen that allow you to easily edit groups of data. One way to do this is 
by performing a Global Replace to make the same change to a group of records. 
Another way is to use Find & Replace to edit records on a more selective basis. 
Please keep in mind that you may wish to backup your database before applying 
drastic changes, just in case you change your mind or do something incorrectly. 

 

Global Replace allows you to make the same change to an entire group of 
records with a few short steps. One common use of this feature is to edit the 
Overlay field of a group of names in your Telephone Book to organize that 
database better.  

To perform a Global Replace, you must remember to include the field you wish 
to edit as one of the selected columns on your search results. Once your search is 
complete, you can click on the Edit menu at the top of the screen and select the 
Global Replace option. 

Modifying Templates 

Global Replace 
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The area at the top that contained your search criteria will now change to show 
your Global Replace options. In the Field Column area, select the column you 
wish to edit from the drop down list. Once selected, you can type your New 
Value in the provided field and Apply your change. 

Please note that this will replace anything that is in the selected column with 
your new value, so be certain that you really wish to perform this action before 
you confirm it. 

Once the update is complete, you can click the Finished button to return to the 
normal Search and Report screen options. 

 

Find & Replace is similar to ones found in most word processors and it allows 
you to be more selective about what is replaced than the Global Replace option. 

You can start this process by going to the Edit menu and choosing Find & 
Replace. This will change the top half of the screen to show you the Find & 
Replace options. 

Type the text you are looking for in the Find What field. If you intend to 
replace this with something else, then enter this in the Replace With field. 
Please note that you can also choose whether this procedure is Case Sensitive by 
selecting the Match Case option. 

Once these fields are complete, click on the Find First button. Time & Chaos 
will then search the data shown at the bottom of the screen for the first place 
your Find What value appears. 

Once the first instance of your search word has been found, you can choose 
Find Next to skip to the next occurrence. 

Quick Replace instructs Time & Chaos to substitute the text entered in the 
"Replace With" data field for the text specified in the "Find What" data field.  
Then it will search for the next occurrence of the text specified in the "Find 
What" data field. Holding down Alt + R keys will force the Quick Replace to 
cycle through and quickly adjust all records meeting Find & Replace values. 

Confirm Replace instructs Time & Chaos to substitute the text entered in the 
"Replace With" data field for the text specified in the "Find What" data field and 
then wait for the user to confirm that the substitution is accepted. After 
confirmation, Time & Chaos will move on to locate the next occurrence of the 
text specified in the "Find What" data field. 

Once you have completed your edits, you can click on the Done button to 
return to the normal Search and Report screen. 

 

To exchange data from one field with the data in another, the Search and Report 
screen offers a feature called Swap Fields. Before you search for records, set 
up column headings for the different fields you wish to swap data between. 
Once your search results are visible, you can go to Edit then Swap Fields. You 
will then have the option to pick the two columns you want to swap information 
between.  This can be very useful if you want to make your phone numbers 
appear in a different order for example.  We recommend that you backup your 
data before doing this, however, because in providing this powerful feature, we 
also allow you to make dramatic changes to your data. If something happens that 
you weren’t expecting, you will have the ability to restore a backup to undo your 
actions if necessary. 

 

Find & Replace 

Swap Fields 
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Transportable Records and Archiving 
In Time & Chaos, Transportable Records are a method of packing up data and 
transferring it to another database or user. Once made, they can be posted on the 
Internet or your Intranet or attached to an email to another Time & Chaos user. 
Transportable records merge into your existing database, so they can also be 
used to help you synchronize two data locations. 

 

To begin, you will need to use the search screen to find the records you wish to 
transport. This can be a search for anything in a database, or just records in a 
particular overlay, or whatever you need.  

If you are using this feature to synchronize data, you may be interested to note 
that there is a field in the database called Last Modified Date/Time that can 
be used to find records you updated in a particular time frame.  

When you have found the records you need, you must highlight the ones you 
wish to package up for transport. In most cases, you would want to highlight all 
of them. The easy way to do this is to click on Edit and choose Select All.  

Finally, under the File menu is an option for Create, where you will find 
Transportable Records. Selecting this will prompt you for a location and 
name for your Transportable Record file. This file must have an extension of 
".IXP". 

 

Opening Transportable Records and merging them into your database is quite 
easy if you can get the .IXP file into the right place. Each database exists in a 
particular directory on your drive. For most users, this directory is "C:\Program 
Files\Chaos32", but it could really be anywhere. When you know the location of 
the database, you can place the .IXP file in that same location.  

Back on the main screen of Time & Chaos, click on the Network menu at the 
top of the screen and choose In Basket. This is where you find "iSBiSTER 
messages" that are located in your directory and merge this data into your 
existing databases.  

When you check the In Basket, Time & Chaos will find the Transportable 
Records and list the data in them for you here. You can select particular ones 
that you wish to accept or delete, or you can select all of them to accept or 
delete.  

Especially if you are attempting to synchronize a database, you will be 
interested to know that as the records are merged into your existing database, we 
are comparing them to the records you already have in your database. If an item 
is new, we will of course add it. If a record is the same as one you already have, 
we will keep just one of the two. 

Please notice that in the In Basket, there is a Duplicates menu. It will allow 
you to control how Time & Chaos will treat any duplicates if found. 

We feel that Transportable Records are an infinitely useful part of Time & 
Chaos. To show it off, the downloads area of the Time & Chaos Web site 
contains some Transportable Records that we produced and are making 
available to our users. Go have a look at www.isbister.com ! 

 

One practical application of the Transportable Records feature is the ability to 
archive your older Appointment and To Do items. Archiving will remove the 

Search and Save 

Open Your Packages 

Archiving Older Data 

http://www.isbister.com/


 

Time and Chaos User's Guide Chapter 7: Special Features  ••••   53 

oldest data that is likely unused but is taking up space and slowing down 
searches. Users with large quantities of Appointments or To Do items may wish 
to archive these databases from time to time just to keep the file sizes down and 
performance to the maximum when doing searches. Here are the basic steps for 
archiving your data: 

1. Go to the Search and Report area for Appointments (or To Do items) and 
search for all the items older than a particular date to find the items that you 
wish to archive.  

2. Once you have found these records, use the Edit menu to Select All, which 
will highlight all the records you found. 

3. With all the records now highlighted, click File, Create, then Transportable 
Records. Making a Transportable Record will package up all the data for the 
records you found, including notes, categories, etc.  When you make this file, it 
should be placed in a different directory than where your actual data files are 
located, and it should be given an extension of .IXP. 

4.  Once you receive a message that the .IXP file was successfully built, you can 
then click on Edit and Delete to remove all of these archived records from your 
database. 

Should you later wish to get these archived records back into your database, you 
need only to move the .IXP file into the data directory and open the In Basket 
from the Network menu in Time & Chaos.  All the packaged records should 
show up there where you could then merge them back into your database by 
accepting them there. 

 

Open / Create New Data Folder 
There may come a time where you want to store information in more than one 
database. If you are in a workgroup, each person will likely want his or her own 
database at some point. The Create New Data Folder and Open Data Folder 
options on the File Menu of the main screen will allow you to create and switch 
between multiple databases. 

When you choose to Create New Data Folder, Time & Chaos will first ask 
for a location to build your new dataset in. This will typically be a subdirectory 
of your current database, but you are welcome to type in your own path if you 
desire. 

If you already have another data folder that you wish to use, you can select the 
Open Data Folder option from the File menu. This will let you look for 
another folder or directory on your computer or network that you wish Time & 
Chaos to read from. 

If you have many data folders that you switch between often, you may also want 
to read the chapter on Workgroups to learn about more advanced features to 
assist you. 

 

Backup and Restore 
The type of information you enter in Time & Chaos is invaluable for "running 
your life". If something were to happen to your computer that might cause a data 
loss, you could have a significant problem. If you value the data you enter in 
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Time & Chaos, it is in your best interest to make backups on a regular basis to 
protect yourself from the unknown. 

A note about Tape Drives: It is important to recognize that most Tape Drives 
can only backup files that are not in use. If you are a network user and are 
trusting a Tape Drive to protect your data, you should be aware that if someone 
leaves Time & Chaos running while the Tape Drive attempts to backup the files, 
the Tape Drive will be forced to skip the files and will leave you with nothing. It 
is vital that you protect yourself by using our built-in backup option, even if you 
also have a Tape Drive. 

 

Time & Chaos makes it very easy for you to backup your data. You can simply 
choose the Backup Data option under the File menu on the main screen of 
Time & Chaos. You can also choose an option to have us remind you to backup 
when you exit the Time & Chaos program. 

Time & Chaos will compress each of its databases, give them a file extension of 
.BAK and store them in your current Data Folder with your other Time & Chaos 
information. The backup files will be named APPT.BAK, PHONE.BAK, and 
TODO.BAK for your Appointments, Telephone Book Entries, and To Do list 
Items, respectively. 

Backup supports both local and the common Telephone Books, the To Do list 
and Appointments. Backups can even be made even while other users are using 
your data! 

When you backup, you are given an opportunity to select a location. The default 
choice for you should be Local Folder, by which we mean the current location 
of your actual Time & Chaos data files.  You can also choose to have these 
backup files copied to a 3½ Floppy (A:) or to Browse to a new location of 
your choice. 

Note: Because the Backup Data option always creates files with the same 
names, it is important to remember that if you have more than one database, 
each must be backed up to a different diskette or different directory. If you 
backup two different data folders to the same location, only the most recent 
backup will remain! 

 

If you want to bring in data from a Backup, you can use the File menu to find 
Restore Data. You can select the information from your backup to "replace" 
that currently in your Data Folder. Your options include Appointments, To Do 
List Items, and Common or Personal Telephone Book Entries. 

NOTE: Restoring data overwrites the existing data. It does not merge. 

When you restore, you will be given an option to indicate where your Time & 
Chaos 5 backup files are located. This could be in the Local Folder where the 
main data files are found, a 3½ Floppy (A:) or any location you can Browse 
to. When you select a location, the Restore function will first copy the files to 
your local folder, then it will allow you to select what items you wish to restore. 

If you are upgrading from version 4.x of Time & Chaos to our current version 5, 
Restore Data is NOT the way to bring your old data into this new program. 
Instead, use the Start button in Windows to find the Time & Chaos folder with 

Backup Data 

Restore Data 
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all of our shortcuts. One shortcut titled Convert v4.x Data can be used to 
convert and transfer your old data to our new Time & Chaos program. 

 

Importing Data from other sources 
Time & Chaos can import data from many other programs or data sources to 
save you from retyping information. The most common format between 
programs is ASCII data 

 

Time & Chaos can import data from either an ASCII Tab Delimited File or 
ASCII Comma Delimited File. (Sometimes, this file type is also referred to as a 
CSV or Comma Separated Values file.) Most address book packages can export 
data in this format. An ASCII Comma Delimited File is actually a text file with 
each line of that text file being a record of information. Each field within a 
record will be separated with commas or tabs. 

The Import Screen allows Time & Chaos users to add new records to any of 
their data collections (i.e., Appointments, To Do List Items or Telephone Book 
Entries). The procedure involves informing Time & Chaos of the file that the 
new records will come from and the Time & Chaos data collection to which they 
will be added. The user must also educate Time & Chaos on the association 
between the data fields in the input file and the data fields within the target data 
collection. 

 

To import, click on the File menu on the main screen and select Import Data. 
The process of importing will involve four steps. You will have to find the 
ASCII text file, select the type of ASCII information, select a destination in 
Time & Chaos, and them map the fields to show where the data belongs. 

1. Select the ASCII file: The user must select the file from which new records 
will be read. This is accomplished by initiating the browse feature by clicking on 

Importing ASCII Data 
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the icon that looks like a file folder. The selected file must be an industry 
standard ASCII import file. 

2. Select the File Type: The user must specify the file type by choosing either 
ASCII Comma Delimited or ASCII Tab Delimited. 

3. Select the Import Destination: The user must specify the Time & Chaos data 
collection to which the new records are to be added. The user must choose 
Telephone Book, Appointments or To Do List. 

4. Data Field Matching: The user must "educate" Time & Chaos on the 
association between the data fields in the input file and the data fields within 
Time & Chaos. In the lower section of the Import Screen the user will find two 
graphical controls. The control on the left will contain the data fields as they 
were found within the Import file. The control on the right will contain the data 
fields available within the Time & Chaos target data collection. The user must 
now perform a matching exercise.  

The matching (left and right) can be performed in any order and can be 
corrected if mistakes are made. Let's review how this might happen. The 
matching exercise involves dragging a field from the control on the left 
(incoming data) over to the control on the right (Time & Chaos field) and 
dropping the item into the appropriate field. Time & Chaos will show the field 
name chosen from the control on the left to indicate the association. This process 
is repeated until all desired associations are specified. 

If fields in the incoming data do not match with any of the Time & Chaos fields, 
simply leave them out of the association process. If a mistake is made while 
mapping the fields, you should double click on the Time & Chaos field in error, 
which will clear the association for that field. Repeat the drag and drop 
operation to correctly define the association. 

Special note: if you import data from the same source repeatedly, there is an 
additional feature in the Import screen that may be useful to you. There are 
buttons at the bottom of the screen to Save Map File or Open Map File. Once 
you have mapped out the field matching the first time, you can then save this 
mapping for future use. If you ever import the an ASCII file with the same 
format and fields, you can then use Open Map File to find the settings you saved 
without having to perform all of these steps again. 

 

Time & Chaos supports the vCard standard to import Telephone Book data into 
the Time & Chaos Contact area. If you have received a .VCF file that you wish 
to add to Time & Chaos, just double-click on it in your Windows Explorer to 
automatically bring open a Time & Chaos import screen for the item.  

If a Time & Chaos import screen does not appear, this could mean that Time & 
Chaos is no longer the default program for files with a .VCF extension. You 
may wish to update your Windows settings or re-install Time & Chaos to correct 
this. 

 

If you have been using Microsoft Outlook and found Time & Chaos as a better 
alternative, we welcome you! We have a special utility on our web site that can 
speed the process of importing your Outlook data into Time & Chaos. It is 
available free of charge on our web site and is named Outlook Extract. 

 

Importing vCard 
information 

Importing data from 
Microsoft Outlook 
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Chapter 8: Preferences 

Display Preferences 
Normally, Time & Chaos will start with a Monthly Calendar, Telephone Book, 
Appointments and To Do List areas visible and all the current data displayed. 
However, you might want to start with the screen a little larger, or have the 
Telephone Book sorted by Company Name, or have the Telephone Book show 
just names in your Business Overlay instead of the entire database.  

Besides using your mouse to resize areas of the main screen, there are Screen 
Layouts under the View menu. These Screen Layouts allow you to completely 
change the look of the main screen. 

If you put everything just the way you like it and want Time & Chaos to 
remember to look this way the next time you start it, use the File Menu and 
choose the option to Save Startup Settings. The display options you set up 
will now be in effect each time you restart Time & Chaos. 

Later, if you change your mind, you can always use the File menu and choose to 
Reset Settings to Default. This will undo all the specific display settings 
you made and return the display to the "factory settings". 

There are many settings, by the way, which are saved when you choose the Save 
Startup Settings option. The items saved are  
• the Screen Location, 
• the Time & Chaos Window Size,  
• the sizes of each of the four areas within Time & Chaos,  
• the column widths,  
• the size of the name and address area in the address book section, 
• the sorting options,  
• the gridlines,  
• window selections, locations and sizes,  
• Overlay filters,  
• leading/trailing dates in the Calendar,  
• week numbers or day numbers choice,  
• toolbar options, and  
• use of common or personal telephone books. 
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Program Preferences 
If you click on the File Menu on the main screen, you will find the option for 
Preferences. The Preferences screen is divided into sections listed on the left of 
the window to organize the various preferences you can control. 

 

Current Data Folder Name is a way to identify this database. The name 
supplied here will appear at the top of the main screen. It will also be seen in the 
User List if this database is part of a workgroup. 

Default Start-up Folder Location specifies where Time & Chaos will find 
the data when it begins, no matter how you manage to start it. You cannot type 
in the location because you are already in the right location if you are in your 
database. To set Time & Chaos to start with the database you are currently 
using, just click on the Use Current Folder button. It will fill in the field with 
your current location, whatever that may be. You can click on the Reset button 
to empty this field.  

Note: If the Default Start-Up Folder Location is left blank, Time & Chaos will 
look for data in the "Start In" location defined by your shortcut in Windows that 
you used to start up the program. 

Date Format and Time Format allow you to specify how you would prefer 
dates and times to be displayed inside of Time & Chaos. Please note that this is 
not necessarily the same as your Windows settings found under Regional 
Settings in your Windows Control Panel. Notice that Time & Chaos always 
requires a four-digit year. This Time & Chaos hallmark ensures Year 2000 
compliance. 

Word Processor allows you to select which program you are using on your 
system that can be integrated with Time & Chaos. Currently supported are 
Microsoft Word XP, 2000, 97, Word 95 and Corel WordPerfect (7 to 2000). 

Minimize to System Tray allows you to control where you will see Time & 
Chaos on your Windows Start Bar when you minimize the program. The System 
Tray is the area next to the clock, and minimizing to the system tray will put our 
icon in that space when minimized instead of continuing to take up space on the 
current applications side of the Start Bar. 

Note: Using the Minimize to System Tray option will prevent Time & Chaos 
from being able to open multiple times. Depending on your situation, this might 
be a good thing or a bad thing! 

Use Quick Fill Fields will allow Time & Chaos to help you as you enter new 
data. Information such as City and State will be "remembered" as you enter new 
records. As you enter records and begin to type in fields, Time & Chaos may 
suggest the full text to save you from typing it. For example, if I have already 
made some Telephone Book entries for people in New York, NY, when I get to 
the City field and type "N", Time & Chaos will suggest the first city that begins 
with N and may fill in New York for me automatically. You can keep typing to 
ignore the suggestion, or just move to the next field to retain the suggestion.  

If you want to remove an item from the Quick Fill list that has been suggested, 
you can just press your delete key in the field you are typing in. The field will 
become blank and that particular item will be removed from the Quick Fill 
database. 

General Options 
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Default Alarm .WAV File allows you to point Time & Chaos to the sound file 
that you would prefer to play when Time & Chaos notifies you regarding a 
scheduled Appointment. You will still have the opportunity to edit this choice 
on individual Appointments, if necessary. 

Mail Notification .WAV File allows you to choose a sound that Time & 
Chaos will play whenever a new item is placed in your In Basket. This will 
allow you to receive an audible notice in addition to the "on-screen" alerts. This 
feature primarily applies to users in a Workgroup environment. 

 

If you share your PC with another user, or if your data is accessible to others 
through a network, you may want to make your data folder private and protect 
your data from being viewed by others. If so, the Passwords area will allow 
you to put password protection on your data files. 

The Passwords area has two password fields; one for Full Access with read 
and write abilities granted to all users and the other for Read Only access.  

Note: You must specify both passwords if you want to use the Password feature, 
even if you do not intend to use the Read Only password. They must also be 
different passwords! 

Once you have entered passwords and saved your settings by clicking OK or 
Apply, anyone, including yourself, must now supply a password to enter this 
database. The read only password will allow the person using it to view all the 
data in the database, but not make any additions, edits, or deletions. Using the 
read and write password will allow the full access you normally have. 

Please keep in mind that using Passwords will allow others to see everything in 
your database or to see nothing at all. There is not a way to mark only certain 
records as private and others as public. 

 

These allow you to specify your Workgroup options if you are in a situation 
where you have more than one database that you would like to work together. 
After setting up a workgroup, you will be able to switch easily between 
databases and transfer items to the other databases. 

Please refer to the chapter on Workgroups for detailed information on each of 
the options available here. 

 

This section allows you to enter a Primary Return Mailing Address and a 
Secondary Return Mailing Address to be used on any Envelopes printed 
by Time & Chaos. You can also control the way addresses appear on reports, 
envelopes and mailing labels by selecting the Send To Mailing Address 
Format that applies to your part of the world. 

 

The Appointment Options section provides you some special options for 
working with your scheduled items. 

Default Day Start Time for new Appointment entry lets you select the initial 
start time for new appointments, which will be visible when you use the drop 
down list to select a start time. This value will also affect the start time of the 
Day Plan printout timeline. 

Passwords 

Network Setup 

Addressing Formats 

Appointment Options 



60  ••••   Chapter 8: Preferences Time and Chaos User's Guide 

Drop Down Time in increments of is a choice that will affect only the drop 
down list of times.  If you use the drop down list or your arrow keys to change 
the start time or end time of appointments, this value will control whether it 
jumps by 10 minutes, 15 minutes, 30 minutes, or 60 minutes. 

Use Calendar Day Colors allows Time & Chaos to use the color of the first 
appointment on any given day to colorize the day number in the Calendar 
window. This option is turned on by default, but if the colors are distracting to 
you or if you have a lot of appointments and want to see a performance gain, 
you can turn this option off and all of the day numbers in the Calendar window 
will simply appear in normal text. 

Default to Sound Alarms on new Appointments will control whether 
alarms are automatically selected on new appointments. Default Alarm Lead 
Time (in minutes) will be the default choice on new Appointments as well. Your 
selections here will just be the default choices on new Appointments. You can 
still edit individual items to choose to turn off or on the Alarms and select a 
different Lead Time. 

Appointment Alarm Mode controls how Time & Chaos will respond to 
Appointment Alarms. Disable Alarm Checking will tell Time & Chaos to 
ignore all alarms, regardless of any individual settings. Current Alarms Only 
is the default choice, which will tell Time & Chaos to give you alarms only as 
they occur. If your computer is turned off or if Time & Chaos is not running 
when an appointment occurs, you will not receive notification. If you want Time 
& Chaos to remind you of current Appointments and any Appointment Alarms 
you missed, you can also set this option to Both Current & Past Alarms. 

When you drag a name from the Telephone Book to your Appointment area, the 
description of the Appointment will normally specify "Meeting with XYZ 
Corporation". Default Prefix when dragging from Telephone List allows 
you to change the default of "Meeting with" to something else, if you prefer. 

Enable Warnings of Appointment Conflicts will allow Time & Chaos to 
warn you if you enter a new appointment that has a time conflict with an 
appointment previously entered. 

1st Day of Week Begins on can be set to Sunday or Monday, depending on 
your preference. This will change the calendar on the main screen as well as 
affecting any printouts you make. 

 

With the To Do Options section, you can first customize the default To Do 
priorities. The normal defaults of A, B, C, D, E, P, T can be changed to anything 
you desire, such as 1, 2, 3, 4, 5, 6, 7 or whatever. You can also customize the 
colors used for each priority level you define by clicking the button with the 
three dots just next to the priorities you have listed. 

Note: These default priorities will be used by  Palm devices to match up the 
Palm Priorities 1-5 with the first five priorities set up here 

You can also specify the Default Priority level for new To Do items. This 
can always be modified on an individual basis, but this choice will be the default 
when you create a new item. 

However, if you create a new item by dragging a name from your Telephone 
Book to the To Do area, the To Do item will use the next two fields on this 
screen to determine the Default Priority when dragging and the Default 

To Do Options 
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Prefix. Normally users drag names for people they intend to call, so Time & 
Chaos creates an item with a T(elephone) priority and a Call prefix. 

Finally, you can also turn on or off the Use Strikeout Font on Completed 
Items to control whether Time & Chaos will "cross off" the To Do items as you 
mark them as Done. 

 

Time & Chaos has the capability to check your spelling almost anywhere in the 
program! Whether you are in the notes area or just in a normal field, our spell 
checker can help to correct any errors you may have made.  

The Spelling Options found in the Preferences will allow you to set and control 
what kind of spell check help and how much help to give you. 

You can configure the spell checker to Ignore words with numbers, Ignore 
words in UPPER CASE and Ignore words with Mixed Case. 

While the spell checker can be used on demand using the F7 key, you can also 
have the spell checker work automatically. You can select the option to Spell 
as you type to have misspelled words indicated immediately with a red 
underline.  

The option to Display Suggestions as you type List will allow Time & 
Chaos to warn you instantly of unrecognized words and let you fix the problem 
immediately. It provide you a popup menu with a list of suggested spellings to 
choose from, as well as allowing you to add your word to the dictionary if your 
word is spelled correctly but not recognized. 

Note: If you find the spell check interruptions annoying, you can turn all 
interruptions off by un-checking the Spell as you type and Display Suggestions 
as you type List checkboxes! With these boxes unchecked, spelling will only be 
checked if you press the F7 key on the keyboard. 

 

The appearance of the main screen of Time & Chaos can be customized with 
your selection of Wallpaper textures and/or your own font preferences. 

Wallpaper textures can be displayed as the background of the main screen 
windows. Time & Chaos includes a list of textures from which you can choose 
your favorite or you can choose None to display the traditional plain background 
colors. 

If you would like to add your own additional textures to this list, just save your 
textures as a .JPG file and place it in your Time & Chaos directory. It will 
automatically be added to your list of available textures. Please note that the font 
color will always be set to black, so you should avoid textures with dark colors. 

Default Font allows you to select a font and a font size of your choice for use 
on the main screen displays. 

 

Spelling Options 

Appearance 
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Toolbars 
Time & Chaos has toolbars at the top of each window to allow for easy access to 
the powerful features of the program. These toolbars allow you to add and delete 
items, filter your display, run a search, print out reports and more. These 
toolbars can also be customized to match your specific preferences.   

To customize a toolbar, right click on it and select Customize... from the pop-
up menu that will appear. 

A Customize window will appear with a tab for Commands. Click on the 
Commands tab and you will see a split screen of Categories and Commands.  
Just select a category to see all of the available commands that you can add to 
your toolbar. If you find a command that you want to have easy access to, click 
on the command and drag it to the toolbar and drop it in the position you want it 
to be in. 

You can remove buttons from your toolbar by dragging them from the toolbar to 
the Customize window. You can also rearrange the buttons on the toolbar by 
simply dragging them and dropping them in their new position. 

As a final step, once you close the Customize window, you MUST click on File 
and then on Save Startup Settings to have Time & Chaos remember your 
customized toolbars for the future. 
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Chapter 9: Workgroups 

Do you need a Workgroup? 
Workgroup features can be one of the most valuable ways to work smarter, not 
harder, in your business or at home. Before you build a workgroup, however, 
there are a few things you should think about. 

Do you plan to have just one database that multiple users will share? If so, you 
don't need a workgroup! You can just setup the Preferences on each user's PC to 
start in the same location and work with the one database you have. (This is 
perfect, by the way, for bosses with secretaries that wish to simply share one 
database) 

Do you plan to have more than one database? Do you want to easily switch 
between them or send items from one database to another? If so, setting up a 
workgroup is exactly what you need. Having a workgroup will allow you to 
view each other's data and to send other databases Appointments, To Do items 
and Telephone Book listings. 

If you decide that you do need a workgroup, the next thing to consider is what 
type of workgroup to create. 

 

Types of Workgroups 
Time & Chaos offers three different types of workgroups for you to choose 
from. The correct choice will depend on whether you have a network and if so, 
what type of network setup you have. These choices include Single User 
Workgroup (if you don’t have a network at all), Peer-to-Peer Workgroup and 
Client-Server Workgroup. 

 

This allows you to function as a stand-alone user that may have multiple data 
folders. You can then use the "workgroup" features even though all the files will 
exist just on one machine. This is the default. Data folders can be located 
anywhere that you are able to store data from your PC. You may have Time & 
Chaos data on your C drive, and a different set of data on your F drive and yet 
another set of Time & Chaos data on a server. The key here is that the data will 
only be accessible from YOUR PC. 

 

Single User Workgroup 
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Your network is capable of hosting a Peer-to-Peer Workgroup if you can open 
your Network Neighborhood or your Network Places and see a list of each and 
every computer on your network. If you can only see the server and not other 
individual machines, you will be forced to use the Client/Server Workgroup 
instead. 

In Peer-to-Peer workgroup, the Node Manager files and the data folders may be 
located virtually anywhere on the network. Typically, users keep their Data 
Folders on their local hard drive. All users must connect to the Node Manager 
by specifying its address using the Universal Naming Convention path (UNC). 

For example, you might have databases located on 
\\David\C\Program Files\Chaos32\ 
\\Bill\C\Program Files\Chaos32\  
\\Debbie\C\Program Files\Chaos32\ 

Keeping different databases on different networked computers would require 
you to use a Peer-to-Peer Workgroup. 

Keep in mind that if you create a Peer-to-Peer workgroup, each user must share 
the data location to make it available to everyone else, with full read, write and 
shared access. If a user wants to enjoy workgroup privileges but protect their 
data, they can use password protection in their Preferences. 

Note: The use of an Universal Naming Convention path or UNC eliminates the 
need to use a Mapped Network Disk Drive. It is much better to use an UNC than 
a mapped drive because an UNC will be the same on each and every machine on 
the network. The same guarantee cannot be made about each and every 
computer having the same network drive mappings. 

 

In a Client-Server workgroup, all Time & Chaos Data Folders must be located 
under a Parent Folder on a common drive, usually on a network server. The 
Node Manager files must be located in this Parent Folder. Each user's Data 
Folder would be a child of the Parent Folder.  

For example, in a Client-Server relationship, you would have databases located 
in: 

\\Server\Chaos\Bill\ 
\\Server\Chaos\David\ 
\\Server\Chaos\Debbie\ 

Each and every database in a Client-Server workgroup MUST be in a 
subdirectory of the same master folder, just as shown in the example. If there is 
a database located in another part of the server or on a local machine, it will not 
be able to join this type of workgroup, but would instead have to be moved to 
the same location as all the other databases. 

Remember that all users must be granted full read, write and shared access to the 
Parent folder as well as all of the user directories under it in order for the Client-
Server workgroup to function properly. If a user wants to enjoy workgroup 
privileges but protect their data, they can use password protection in their 
Preferences. 

If you are using a Novell server, you should keep in mind that Novell servers do 
not allow for sharing by default, even if you have granted full read and write 
access to the directories. Your Novell Administrator must use the “flag” 
command to set this attribute and ensure that shared access is available for all 
users.  

Peer-to-Peer 
Workgroup 

Client-Server 
Workgroup 
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Note: The Time & Chaos program should always be installed on the Local drive, 
no matter where the data files are to be stored. Time & Chaos does not need to 
be installed on the server unless someone will actually be sitting down at the 
server to use it like another workstation. 

 

Setting up a Workgroup 
Setting up a workgroup for multiple Time & Chaos data folders requires two 
steps: the creating of a new workgroup, then the connection of each database to 
the new workgroup. You can find the network setup by going to File, then 
Preferences, and then clicking on Network Setup on the left. 

Time & Chaos displays the current Network Settings for the database you are in. 
These include the user's Data Folder Name, Data Folder Location, Workgroup 
Type and Node Manager Data Folder Location.  

At the bottom of the Network Setup screen, you can choose to build a new 
workgroup or to connect to an existing workgroup. 

 

 

The first time you setup Time & Chaos for workgroup use, you need to build a 
workgroup database. Building a workgroup is usually just a one-time job. Under 
most circumstances, you will only have one workgroup for your entire network 
of users. 

When you build a new workgroup, you will end up creating a set of files named 
NODEMAN.ISD, NODEMAN.ISM, and NODEMAN.ISL. These files are the 
Node Manager files, which you will see references to throughout this process. 
The Node Manager files control the workgroup and keep track of what databases 
are in the workgroup, what the name of each database is, and where it is located. 

To build a new workgroup: 
1. Open a database you want to be part of your new workgroup, if you are not 

already in one. 
2. Go to the File menu, then to Preferences. 
3. Select Network Setup on the left. 

Build a new 
Workgroup 
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4. Look for and select the option for I want to build a brand new 
workgroup. 

5. Select your Workgroup Type as Single User, Peer-to-Peer, or Client-Server. 
If you are unsure which is best for your needs, you should re-read the 
section on Types of Workgroups. 

6. Specify the location for the Node Manager files. Be sure to specify a path 
that each workgroup member will be able to reach and has full network 
permission to use. 

7. Click OK to finish 

As you complete this process, Time & Chaos will give you an opportunity to 
place an Administrative Password on the Node Manager files. This is not a 
requirement and most users do not need it, but if you are an administrator of a 
large workgroup, you may want to take advantage of this feature. If you choose 
to add the Administrative Password, you will need it again and again to maintain 
the workgroup and delete users from the User List. 

Once a workgroup exists, you can then begin to connect databases to the 
workgroup. 

Note: All users will require read, write, and shared access to the folder 
containing the Node Manager files. If a user does not have these rights on the 
network, they will not be able to connect to the workgroup or use the workgroup 
features! 

 

 

Connecting your database to a workgroup will let you easily navigate between 
databases, let you send records back and forth to other databases, as well as use 
many other Workgroup features. 

Before you can connect to a workgroup, however, you need to make sure that 
the database you are using is available to all users of the workgroup. When you 
are on a network, each person in your workgroup will need permission to your 
data folder with read, write and shared access. (If you want to make your data 
private, you would do that with Passwords, not with Network rights!) 

If you are planning to connect to a Client-Server workgroup, you should also 
make sure that your current database is located in a sub-directory below the 

Connect to an 
existing Workgroup 



 

Time and Chaos User's Guide Chapter 9: Workgroups  ••••   67 

Node Manager location. If your current database is anywhere else, you won’t be 
able to connect until you move your database to the right location. 

 

Step 1: Data Folder Location for NODE MANAGER 
This field must be filled in with the location on your computer or network of the 
Node Manager files for the workgroup. (These files are named 
NODEMAN.ISD, NODEMAN.ISM, and NODEMAN.ISL.) 

At the end of this field, there is a Browse button (with a folder icon) to let you 
browse for the Node Manager Files rather than typing the path yourself. With 
the browse screen, you will need to locate the NODEMAN.ISD file for the 
workgroup you are connecting to. 

If you are connecting to a Peer-to-Peer or Client-Server workgroup, you should 
ALWAYS browse for the Node Manager files through the Network rather than 
using a mapped drive or a local drive. This will create a path using an UNC with 
a \\Computer Name\Drive\Directory\ format. 

If this database is already connected to a workgroup, the current location of the 
Node Manager files will already be displayed. If you want to connect to a 
different workgroup or if you want to fix the Data Folder location found in Step 
2, you can click the browse button to reselect the location of the Node Manager 
files.  

Step 2: Your DATA FOLDER location 
Once you select the Node Manager Location, the field for Your Data Folder 
Location should be filled in automatically. The path to your data folder will be 
stored in the Node Manager files and will allow the members of the workgroup 
to find you as a member. 

This field cannot be modified directly. If you need to change the location 
because it is wrong, you need to go back to Step 1 and re-browse for the Node 
Manager files. When you do, it will automatically fix the Data Folder path in 
this step to reflect your current location. 

Step 3: Custom Settings 

The Icon Choice lets you select an Icon to associate with your current 
database. This graphical symbol will show up in the User List to help identify 
each database in your Workgroup 
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The option to Use Common Workgroup Telephone 
Book allows networked Time & Chaos users to maintain a 
shared Telephone Book in addition to their personal 
telephone book. This Common Telephone Book will be 
stored in the Node Manager location and will be shared by all 
workgroup members. Each user will have full read and write 
access to the Common Telephone Book, in addition to their 
personal telephone book located in their own data folder. 

When you choose to use a common workgroup telephone 
book, you will see a new button on the toolbar in the 
Telephone Book window. This new button will allow you to 
toggle between the Common and personal telephone books. 

Click the OK button to save your new network settings. This 
database will be added to the User List and will be available 
now to other workgroup members. 

If you have other databases to connect, you can return to the 
main screen to switch to another database, then repeat this 
process. 

 

Special Workgroup Features 
The User List shows you all of the different databases in your workgroup. Each 
member of the workgroup will be listed by the name of the database with 
matching icon. 

Even though this feature is called a  “User” List, it is actually just a list of your 
different databases. Most of the time, this does mean each user is listed, but in 
your office you might want to have a database for conference rooms or other 
scheduled resources. Those databases should be connected to the workgroup and 
should show up in the User List too! 

A double-click on an icon instructs Time & Chaos to open the Data Folder that 
belongs to the selected workgroup member and display its data on the main 
screen of Time & Chaos. This information (i.e., Appointments, To Do items or 
Telephone Book Entries) will be displayed instead of the information that was 
previously being viewed. If the selected Data Folder is password protected, you 
must provide the proper password to obtain access. 

A single-click on an icon selects a workgroup member for further action. To 
select more than one workgroup member you must combine the use of the [Ctrl 
Key] or the [Shift Key] with the left mouse click. Holding down the [Ctrl Key] 
while clicking allows you to manually select specific individual workgroup 
members. Holding down the [Shift Key] while clicking allows you to manually 
select a group of workgroup members. 

There are also some menu options in the User List area to help you maintain 
your workgroup and to control your preferences. 

Save Window Location, Reset Window Location, and Always On Top 
allow you to set up your display preferences. The Always On Top button should 
normally be left on so that you can drag items from Time & Chaos to the User 
List for item transfers. 

User List 
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Large Icons, Small Icons, and Details are simply different ways to view the 
User List. The choice you make is entirely up to your preferences and needs. 
Large Icons is the default and it will show the icons chosen for each database in 
the workgroup. Small Icons compresses the list to fit in a smaller space, which is 
perfect for longer lists. Details will let you see not only the names and icons, but 
also the location of each database. 

Delete User from Node can be used if a database is still listed in the User 
List after you no longer wish to have it be an active part of this workgroup. 
Highlight the user you wish to remove and then choose this option. If there is an 
administrative password on this workgroup, you will have to supply the 
password before the user will be removed. 

Validate File Locations will tell Time & Chaos to check the paths to each of 
the databases that are part of the current workgroup. Time & Chaos will test 
each of the listed data locations to ensure that they exist and contain Time & 
Chaos data. If a test fails, the missing database will be removed from the User 
List automatically. 

 

Trying to get people together for a meeting has never been easier! Using the 
TimeBar Screen, Time & Chaos provides the user with insight into his/her time 
commitments (Appointments with Start and End times) via a graphical grid of 
rows and columns. All such Appointments in the current month are displayed. 

Each row represents one hour within the 24 hours of the day and each column 
represents one day in the month being displayed. Buttons are available to 
navigate backward and forward one month at a time. 

TimeBar will allow you to review the "booked" and "available" blocks of time 
so that have the knowledge you need to schedule appointments for yourself and 
your group. 

For the owner of the current calendar set, when you click and hold down the left 
mouse button while over your time allocation, you will see the time and 
description displayed. This is only true for the owner of the current calendar set. 
You cannot see the details for other members of the network. You can only see 
their time allocation. 

The TimeBar Screen was designed to function in a workgroup setting. If you are 
connected to a Time & Chaos workgroup, you will also be presented with the 
User List along with the TimeBar Screen. 

To add a workgroup member's appointments to the TimeBar double click on 
their icon in the user list or drag their icon from the User List and drop it on the 
grid. You can multi-select members of the group at one time by holding down 
on the control key and clicking on all the members you wish to add and then 
double clicking on one of them. 

As the Appointments for workgroup members are added to the TimeBar display, 
different colors are used so that their time commitments can be distinguished 
from those of other workgroup members. The Data Folder Name for each such 
displayed workgroup member is added to a list at the right side of the TimeBar 
Screen. Thus, you will have a "legend" that corresponds to the colored blocks of 
time currently displayed. 

If you wish to remove a workgroup member's Appointments from the display 
(for clarity), you simply click on their Data Folder Name (in the list at the right 
of the screen). 

A few buttons on the screen provide valuable actions you should know about. 

TimeBar 
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Previous Month instructs Time & Chaos to move to the month just prior to 
the one currently being displayed and refreshes the display with the 
Appointments found in that month. 

Today instructs Time & Chaos to return to the actual current calendar month 
and refresh the display with the Appointments found in that month. 

Next Month instructs Time & Chaos to move to the month just ahead of the 
one currently being displayed and refreshes the display with the Appointments 
found in that month. 

New Appointment allows you to add an appointment to your database based 
on the information you see here in the TimeBar screen. Please note that it does 
not send that appointment to other databases - you will need to send it yourself. 

Close instructs Time & Chaos to exit the TimeBar Screen. 

 

 

If you are part of a workgroup in Time & Chaos, you can easily send a single 
Appointment, To Do or Telephone Book item to any other calendar in your 
workgroup. Just highlight the items you wish to send, right click to bring up the 
pop-up menu, point to Send To and choose the person to whom you wish to 
send the items. 

If you want to send an item to more than one person, or just want another option, 
there is a second way to send items. Open the User List to see the list of 
calendars and highlight one or more users or data folders to whom you wish to 
send an item. Once they are highlighted, simply find the appointment, to do, or 
phone book item you wish to send and drag it to the User List window. When 
you drop it, it will automatically be sent to all the highlighted users.  

Time & Chaos will make a file with an extension of "IXM" (iSBiSTER 
Exchange Message) in the selected users' data folders. The other users can now 
accept the item through the In-Basket. If the user that you are sending to is not 
currently connected to your network even though they are in your workgroup, 
Time & Chaos will store the message and will forward it to the recipient when 
they reconnect their machine. 

Item Transfers 
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If you want to send items to a user whom you are not in a workgroup with, or if 
you want to send more than one record at a time, you should use the search 
screen. Find all the records you wish to send and then highlight them. Once 
selected, click File, Create, and Transportable Records to package up all the 
records you found into a single external file with an extension of "IXP" 
(iSBiSTER Exchange Package). This IXP file can be placed in another user's 
data directory to give them the data, emailed it to them, or even posted on your 
web site. 

 

The In-Basket is used to accept Appointments, To Do Items or Telephone Book 
listings either which have been sent to you by another Time & Chaos user, or 
that you have downloaded yourself.  

To open the In-Basket, you can use the In-Basket button on the main screen or 
the menu option under Network. If Time & Chaos is aware of items waiting for 
you in the In-Basket, the button on the main screen will look as if there is mail 
in the mail-slot. If you have chosen a Mail Notification .WAV file in the 
Preferences screen, this .WAV file would also play periodically to remind you to 
visit the In-Basket to deal with the items waiting for you there. 

If there is data that you know exists but is not found by the In-Basket 
automatically, such as a Transportable Record, you can use the File menu and 
select Open Package to browse for the file. 

The In-Basket allows you to view the incoming items, even the Notes field, to 
see what exactly has been sent to you. With your approval, you can Accept the 
items and they will be merged into your existing database. If you do not 
approve, you can click on the Delete button to remove it without adding it. 

If you have a large number of items that you wish to accept or delete as a group, 
you can use the Select All button to highlight all of the items in your In-Basket. 

Sometimes the items you add to your database may be duplicates of items you 
already have. You can control how Time & Chaos will react to any duplicates 
found by using the Duplicates menu at the top of the In-Basket. You can 
choose to Add Both if Not Identical, Replace If Newer, and to Ignore Duplicates 
to keep what you have. 

Replace If Newer is the default choice. This option will let others send you 
newer versions of records you already have. 

Ignore Duplicates would prevent others from sending you edited versions of 
records you already have, but would still allow them to send you brand new 
items you don’t have yet. 

Add Both if Not Identical will not make a judgment on which record is 
better, the one you received or the one you already had. Instead, it will keep 
BOTH, which will cause it to show up twice on your main screen when you 
accept them from your In-Basket. You can then look carefully at the two records 
on your own and fix it up yourself. 

In-Basket 
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Addendum 1: Handheld Device 
Support 

ChaosSync For Palm Computing ® 
Devices 
The best selling personal electronics device for the past few years has been the 
Palm Pilot device. Palms are available from many different companies and many 
designs, but as long as they use the Palm Operating System and have the Palm 
Computing logo, they can work with our Time & Chaos program. This includes 
Palm devices from Palm, the Handspring Visor, the Sony Clie and others. 

To help Time & Chaos users work with their Palm devices, we have an add-on 
utility called ChaosSync for Palm. This utility is not included with Time & 
Chaos, but is available for an additional charge through our web site at 
http://www.isbister.com/ . The current cost of ChaosSync for Palm is $24.95. 

This accessory program will allow you to easily synchronize your data between 
Time & Chaos and your Palm Computing device at the touch of a button, with 
no exporting or special configurations required. 

Time & Chaos and a Palm device become an exciting combination that will 
allow you to take the power of Time & Chaos and place it in your hand! 

The current Requirements for using our ChaosSync for Palm utility to work with 
your Palm compatible device are: 
• Palm Desktop 3.0 or newer 
• Time & Chaos 5.3.9 or newer 

If you do not have one or both of these programs, they are available for 
download on the Internet. The current version of Palm Desktop should be 
available at www.palm.com by going to their Support section, then to Software 
Updates. The current version of Time & Chaos is always available for download 
at www.isbister.com . 

 

To install ChaosSync for Palm, you will need to download this utility from our 
web site and have your installation password available, which you received from 
our sales department when you purchased this add-on utility. 

The file you download from our web site will be named TC2PALM.EXE. 
Double-click on this file to start the installation process. This utility will look for 

Installation 

http://www.isbister.com/
http://www.palm.com/
http://www.isbister.com/
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your Palm Desktop software and for your Time & Chaos program. You have the 
option to let Time & Chaos control your appointments, your to list, and/or your 
telephone book. Once you have chosen which areas Time & Chaos should 
control, the ChaosSync installation program will configure your system 
automatically. It will ask for your password and will complete the installation 
process. 

The final step, which cannot be skipped, is to restart your computer before you 
use Time & Chaos with your Palm device. 

 

When ChaosSync for Palm is installed on your PC, it will add itself to your list 
of conduits in HotSync Manager. To see this list, click on the HotSync Manager 
icon in your system tray (next to your clock) and choose Custom. 

A typical user would see T&C Appointments, T&C Phone Book, and T&C 
ToDo List as three of the conduits listed on the Custom Screen. 

The default action for sending data is Synchronize the files. This option 
allows your information to go both from Time & Chaos to the Palm and vice-
versa.  

If you want or need to change the direction data is sent, you can highlight one of 
these lines, choose Change, then select Desktop overwrites handheld to 
have the Time & Chaos data forced onto your Palm device or Handheld 
overwrites desktop to have the Palm data forced onto Time & Chaos. 

If you change your settings to have one side overwrite the other, please keep in 
mind that any data on the side getting overwritten will be lost. 

Your Palm will sync itself with your default database in Time & Chaos. If you 
want to see where this database is located, or want to change it, you can open the 
main screen of Time & Chaos, select File, Preferences, and look at the second 
line titled Default Startup Folder Location. ChaosSync looks for this location to 
know what Time & Chaos database to synchronize with. 

Helpful Hint! If your batteries fail on the Palm, you will find that your 
information on the Palm is likely to be missing. If this happens to you, you can 
use the information above to setup a one-direction transfer with Desktop 
overwrites handheld to force all of your data to be added again from Time & 
Chaos to your Palm device. 

Note: The Time & Chaos only works with appointments, to do items and 
contacts. Other information on your Palm device such as the Memo Pad area, 
your Palm will continue to sync with whatever software on your PC it was using 
before ChaosSync was installed. For most users, this means your Memo Pad 
information will continue to be synchronized with Palm Desktop, for example. 

If you . . . 

• get a  new computer 

• get a new Palm device 

• move your default Time & Chaos database to a new location 

• lose all the data in your Palm (by run-down batteries or by a hard reset) 

. . . you will need to “Start Over” the relationship between the Palm Device and 
Time & Chaos.  

Using ChaosSync 

Starting Over? 
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Assuming you have the Palm Desktop program with HotSync Manager already 
installed, along with the current ChaosSync for Palm utility from us, you can 
click on the HotSync icon at the bottom of your screen in the Windows System 
Tray. On the pop-up menu, choose Custom. This should provide you a list of all 
the actions which will be taken the next time you sync your device with your 
PC. Specifically on the (up to) three lines that refer to T&C, you should set each 
of these to Desktop overwrites Handheld before you Sync. 

After doing this once, it should automatically revert back to Synchronize the 
Files, but by using the Overwrite option the first time, you re-establish the 
relationship between the Palm device and Time & Chaos and avoid having 
duplicate data or missing data. 

 

You should be aware that such a tiny device as the Palm couldn’t possibly have 
ALL of the features of Time & Chaos. We have outlined below for you some 
tips that will help you get the most out of ChaosSync for Palm with no surprises. 

Telephone Book  -- The Palm does not have as many fields available for 
Telephone Book records as Time & Chaos does. Because of this limitation on 
the Palm, we transfer all of the data we can, but some information will not be 
transferred because there is no place for it to be stored on your Palm. You need 
to be aware that 

The Palm has only five (5) telephone number fields, not the full twenty (20) 
that Time & Chaos offers. Your Palm will only contain the first 
telephone numbers from the five positions and will not see phone 
numbers 6 through 20 stored in Time & Chaos. 

The Palm has only four (4) custom fields, not the full twelve (12) offered by 
Time & Chaos. Your Palm will receive any data in the first four custom 
fields in Time & Chaos, but will not see data in custom fields 5 through 
12. 

The Palm has only one complete address per record, not two complete 
addresses like Time & Chaos. Your Palm will only look for the 
Primary Address and will not see the Secondary Address from Time & 
Chaos. 

Phone Number Labels – Time & Chaos allows you to type in or select any 
telephone number label you wish for any phone number. The Palm, however, 
has a defined list of phone number labels that you must pick from rather than 
typing your own. Its list is also much shorter than the list provided by Time & 
Chaos. When transferring data between Time & Chaos and the Palm, 
ChaosSync is sometimes forced to make changes to the phone labels according 
to the following list: 

Chaos  -->  Palm 

Business  -->  Work 

Home  -->  Home 

Fax:  -->  Fax 

WinFax:  -->  Fax 

SMTP:  -->  Email 

mailto:  -->  Email 

Car  -->  Mobile 

Differences between 
Time & Chaos and 
Palm 
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Cellular  -->  Mobile 

Pager  -->  Pager 

Please note that any phone labels in Time & Chaos that do not match these 
specific choices would be set to a label of Other on the Palm side. Keep in mind 
that changes or additions you make to phone number labels on the Palm side 
will return to Time & Chaos just as they are on the Palm. 

Common Telephone Books – Time & Chaos has an option to use a 
common telephone book in addition to a personal one. However as a personal 
device, the Palm has only one phone book and will only synchronize with your 
personal phone book and not the common one. 

ToDo Items – By default the Palm shows all To Do items regardless of date.  
If you want the To Do items to be displayed similar to the manner of Time & 
Chaos, you may want to click on the Show button and change the options to 
show only active items, or so show by due date. 

Notes – The notes area on your Palm is only able to handle plain text. If you 
have used rich text (colors, font sizes, etc.) in your Chaos notes, this special 
formatting will be lost, although all the actual information will remain intact. 

Notes, part 2 – The Palm’s notes area is more limited than what Time & 
Chaos allows in regards to length. If and only if you have very long notes in 
Time & Chaos, there is a potential issue you should be aware of with notes 
being truncated, due to the Palm's size constraints. 

Repeat Options – The Palm does not store recurring events in the same 
manner as Time & Chaos. The Palm only stores one actual item and does not 
physically copy the item to future dates. As a result, when you synchronize the 
Palm with Time & Chaos, only the original item will be transferred. On the 
other hand, if you set the repeat options in Time & Chaos and synchronize with 
the Palm, all items will be stored in both locations and will show up properly. 

Archive Copy – When you delete a record from your Palm, it gives you an 
option to Save archive copy on PC. This choice will have no impact on Time & 
Chaos, however. The record will simply be deleted from Time & Chaos as well. 
If you want to archive old data, you should instead use the Archive capabilities 
built into our program. More information on Archiving can be found in the 
Special Features section of this guide. 

Private – The Palm provides a checkbox in the details of each record to mark it 
as Private. This choice, however, will have no impact on the Time & Chaos 
databases. The Password protection option in Time & Chaos can only provide 
users with the ability to see every record (albeit with full or read-only rights) or 
to see no records at all. There is not a way in Time & Chaos to pick and choose 
certain records as Public or Private. 

 

Note: Multi System Synchronization should be used with caution and may not 
be your best choice anyway. This option exists for users who require it, even 
with the severe limitations forced on you by this choice! 

When used with ChaosSync, the Palm will establish a committed relationship 
with one Time & Chaos database. This one-to-one relationship would typically 
require that you use one Palm with one Time & Chaos database and never 
attempt to sync your Palm with a second computer. 

Multi System 
Synchronization 
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Time & Chaos does offer some excellent solutions for using a Time & Chaos 
database on multiple computers, either with Backup and Restore, Transportable 
Records, or our add-on utility named TimeSync that will synchronize two Time 
& Chaos databases in a way similar to ChaosSync synching one Time & Chaos 
with one Palm. 

If, however, you decide that you require the use of one Palm with two 
computers, the ChaosSync for Palm utility does offer a special advanced choice 
for Multi System Synchronization. 

This option can be found by going to the Plug-ins menu in Time & Chaos, then 
to ChaosSync. By default, the Multi System Synchronization option is turned off 
and is unchecked. Normally when the Palm sends a record to the PC, it marks it 
as sent and thereafter ignores the record until it is edited again. This greatly 
speeds the synchronize process but also means you cannot sync the Palm with 
more that one computer. 

Should you wish to synchronize to more than one computer, we offer the option 
to use this checkbox to indicate your preference. Please note that you MUST 
check the Multi System Synchronization Option on EACH system you will be 
synchronizing with. Choosing this option, however, has two side-effects. First, it 
can make your synchronize time slower in comparison to not using it. Second, 
you will be limited to using only the fields and features the Palm has instead of 
the full feature set normally offered to Time & Chaos users. 

To begin using this option, please follow these easy but important steps. 
1. Make sure the option for multi system is NOT checked on both computers. 
2. Change your HotSync options for the appointments, phonebook and to dos 

to have the desktop overwrite the handheld on the first computer, then sync 
with these settings. 

3. On the second computer, set the HotSync options to have the handheld 
overwrite the desktop (just the opposite of the first computer) and sync with 
these settings. 

4. Once complete, you can safely check the box for Multi System 
Synchronization on both computers. 

 
ChaosSync for PocketPC Devices 
With growing popularity, PocketPC devices are making inroads in the handheld 
personal data assistant market. Running a special version of Windows CE from 
Microsoft, Pocket PC devices are available from many different companies and 
many designs, but as long as they use the Pocket PC 2002 Operating System or 
another Windows CE 3-based Operating System, they can work with our Time 
& Chaos program. This includes devices from Hewlett-Packard (Compaq), 
Casio, Toshiba and others. 

To help Time & Chaos users work with their PocketPC devices, we have an 
add-on utility ingeniously named ChaosSync for PocketPC. This utility is 
not included with Time & Chaos, but is available for an additional charge 
through our web site at http://www.isbister.com/ . The current cost of 
ChaosSync for PocketPC is $36.95. 

This accessory program will allow you to easily synchronize your data between 
Time & Chaos and your PocketPC device at the touch of a button, with no 
exporting or special configurations required. 

http://www.isbister.com/
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Using the built-in database allows for the smallest possible footprint on your 
handheld's memory (which is no size at all!), but it does mean that there will be 
some areas where your data does not transfer and show up in exactly the same 
way, just because of the differences in database design between Time & Chaos 
and the handheld. Please see the section below for a list of the known 
differences between the two database formats you should be aware of. 

Time & Chaos and a PocketPC device become an exciting combination that will 
allow you to take the power of Time & Chaos and place it in your hand! 

 

The current Requirements for using our ChaosSync for PocketPC are: 
• A Windows CE 3.x powered device such as PocketPC 2002 
• ActiveSync 3.1 or newer 
• Time & Chaos 5.4.0 or newer 
 
If you do not have one or both of these programs, they are available for 
download on the Internet. The current version of ActiveSync should be available 
at Microsoft’s web site at http://www.pocketpc.com . The current version of 
Time & Chaos is always available for download at www.isbister.com . 
 
 
To perform a sync between Time & Chaos and the PocketPC, you can click on 
the double-arrow button on the toolbar or click the Synchronize button on the 
Options screen. A progress window will open to show you what is happening 
during the sync process. This screen will disappear when the sync process is 
finished, but a log file is kept in your data directory that you can refer to later if 
necessary. 
 
When ChaosSync for Pocket PC is installed, it adds two additional buttons to 
your telephone book tool bar. The button with the ? symbol will allow you to 
configure your sync options. Most of these options are straightforward: you can 
select to have T&C overwrite the PocketPC, to have the PocketPC overwrite 
T&C, to skip transferring anything, or the default option which is to synchronize 
the data. 
 
To help speed up the sync process, ChaosSync for PocketPC also has a few 
tweaks regarding the appointments and to do data that reduce the number of 
records transferred to the PocketPC. 
 
Appointments: ChaosSync has a setting to control how much of your past 
appointments are transferred to your device. This does not delete old items from 
Time & Chaos, it will simply prevent Time & Chaos from sending older items 
to your PocketPC. Fewer items send to your PocketPC will result in faster sync 
times. If you prefer to have all of your old appointments transferred, even 
though the sync will take longer, you can turn off this option by un-checking 
this box. When turned on, you can control the number of weeks of old 
appointments sent from Time & Chaos to the PocketPC. 
 
To Do Items: ChaosSync offers the ability to keep a list of completed to do 
items only in Time & Chaos and to remove completed items from the PocketPC. 
You will always be able to get your to do history while in Time & Chaos, but 
the tasks kept on your PocketPC will be limited to just your active or future 
items, just to reduce the memory requirements as well as to speed up the sync 
process between your device and Time & Chaos. If you uncheck this box, 

Using ChaosSync for 
PocketPC 

http://www.pocketpc.com/
http://www.isbister.com/
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ChaosSync will leave all completed items on the PocketPC in addition to 
keeping them in Time & Chaos. 
 
If you make any new selections on the Options screen, clicking the Save button 
will lock them into place for the next sync. 
 
 
Notes with drawings - The PocketPC will allow you to take notes on your 
device that includes drawings or audio recordings in addition to plain text. 
Unfortunately, there is no way to transfer notes to Time & Chaos that include 
these special types of information. If you have notes saved with drawings or 
audio they will only be visible on the PocketPC device. 
 
Although Time & Chaos will not show these items in your notes, it will also not 
delete or remove this information from your PocketPC. As a result, if you have a 
note in this "Pocket Word Ink" or PWI format, you won't be able to transfer 
notes for that record to Time & Chaos, nor will you be able to transfer notes you 
add to that record in Time & Chaos back to your device. If you get rid of the 
drawings and/or audio, your PocketPC will usually change the storage format 
back to plain text and you will then be able to sync the attached notes back and 
forth again with Time & Chaos. 
 
Whether or not you have these special notes, all information stored in other 
fields will continue to transfer. 
 
 
Overlays and Categories - Traditionally, Time & Chaos uses a field called 
Overlay as a general way to organize your entries in Time & Chaos. T&C also 
uses Categories as a way of setting additional attributes for your records. The 
Categories list for the appointments, to do items and telephone book are also 
independent of each other - the labels you set up for the phone book are not 
normally added to the appointment or todo category lists. 
 
The PocketPC, however, only has categories. It does not have anything that 
works quite like the Time & Chaos overlay field. The PocketPC also uses the 
same category list for all three types of data - a label you setup for the telephone 
book will be visible in the other databases as well. 
 
In synchronizing the PocketPC with Time & Chaos, this utility has to first look 
at your current category selections, then merge them together to match the way 
the PocketPC works. As a result, you will find your phone category labels will 
be added to the appointment and todo databases and vise versa. Also, the 
PocketPC will not be able to show you any of your Overlay settings as it has no 
similar field. 
 
 
Repeating or Reoccurring Events - When repeating or reoccurring events 
are added to Time & Chaos, T&C will copy your item to make individual entries 
on each date out into the future. This ensures that our Contact History feature 
will be able to show you each specific item along with the details specific to that 
occurrence. 
 
The PocketPC does not store recurring events in the same manner as Time & 
Chaos. The PocketPC only stores one actual item and does not physically copy 
the item to future dates. As a result, if you entered reoccurring items in the 
PocketPC, only the original item will be transferred to Time & Chaos, not the 

Differences between 
PocketPC and Time & 
Chaos 
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repeats. On the other hand, any items entered or modified in Time & Chaos with 
repeat options be stored in both locations and will show up properly when you 
sync with your PocketPC. 
 
 
Email address labels - Time & Chaos has the ability to work with your 
default email program to help you send messages to contacts you know. This 
requires that each of the phone labels for email addresses is set to "mailto:". 
When you synchronize with Time & Chaos, any data in the PocketPC's Email, 
Email2, or Email3 fields will show up in Time & Chaos as "mailto:" instead. 
 
 
To Do Priorities - On To Do Priorities, the PocketPC only has three specific 
choices that cannot be customized like in Time & Chaos. The PocketPC options 
are High, Normal and Low. To correlate these with Time & Chaos, we have 
chosen to match these with the first three default priorities from the Preferences, 
To Do Items settings. Whatever values are in the first three priority fields will be 
matched up with High, Normal and Low accordingly. 
 
 
Telephone Numbers - The PocketPC has more than enough telephone 
number fields for a Time & Chaos data to use, but on the PocketPC, the field 
labels are hard-coded, meaning that the phone labels cannot be customized or 
changed. When you sync with Time & Chaos, ChaosSync will simply scan your 
Time & Chaos phone numbers for any that have a label that match up with a like 
field on the PocketPC. Unfortunately, if you have any custom labels (like 
customer number) or a label with a person's name or anything else out of the 
ordinary, the PocketPC will not be able to extract that information. It will still 
show up in Time & Chaos, but will not be available when looking at the contact 
data on your device. 
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Addendum 2: Accessories 

Add-on Utilities for Time & Chaos 
Time & Chaos must meet the demands of many types of users: individuals, 
small workgroups, large organizations, and more. The constant struggle is to 
provide a feature-rich program that is still easy to learn and at a reasonable 
price.  

In response to this need, we have made a few add-on utilities available to extend 
the functionality of the main product. These “accessories” for our power-users 
will provide some special features for you at a reasonable cost.  

Here is a list of the utilities currently sold by us, with their current prices as of 
June 2002. You can also visit our web site at www.isbister.com/products.asp to 
get more information about each of these items and purchase any that fit to your 
needs. 

Express Plus email 
Although it can also be used as a standalone product, the Express Plus email 
client is able to share the same address book as Time & Chaos to allow you to 
leverage your existing data. Send out personalized emails to groups or 
individuals and see which incoming emails are from people you know ($35.00) 

ChaosSync for Palm Computing ® Devices 

Uses the HotSync feature of the Palm Computing® Devices from Palm, 
Handspring, Sony and IBM to synchronize data with Time & Chaos ($24.95)  

ChaosSync for Pocket PC Devices 

Connects to devices using the Windows CE 3.x operating system primarily ones 
with Pocket PC 2002 installed, such as the iPaq, Jornada and Cassiopeia to 
synchronize data with Time & Chaos ($36.95) 

Legal Billing 
A valuable tool for busy lawyers and other professionals which tracks billable 
time, expenses, and payments as well as offering reports and basic client 
statements. ($34.95)  

TimeSync 
Provides easy synchronization of Time & Chaos databases for on-the-go 
professionals ($19.95)  

http://www.isbister.com/products.asp


82  ••••   Addendum 2: Accessories Time and Chaos User's Guide 

Sales Opportunity Tracking 
Maintains a database of Sales Opportunities which relate to clients in your Time 
& Chaos Phone Book ($19.95) 

Chaos2WAB 
Provides easy exporting and updating of the Microsoft Windows Address Book 
to contain your current Time & Chaos phonebook data. (FREE)  

Outlook Extract for Time & Chaos 
Automates the conversion of data from Microsoft Outlook to Time & Chaos. 
(FREE) 

Atomic Clock Sync 

Keep your computer time accurate with this free utility to update your PC clock 
with the current time from an Atomic Clock server. (FREE) 
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